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Preface 
This chapter covers 

• Using this Manual  

• Safety symbols and symbols for specific equipment 

• Contact information 

• Service information 

Using this Manual 
Knowing the conventions used in this manual helps make it easy find 
information, as well as to make the PSV5000 machine easy-to-use and 
keep the operator safe. 

Warnings and Cautions 
Special paragraphs with red lines are safety warnings as follows: 

WARNING:  A warning message like this has red text and calls your 
attention to potentially hazardous situations and practices that might 
injure people or cause serious monetary loss. 

CAUTION: A caution message like this has black text and calls your attention to 
potentially hazardous situations and practices that might damage equipment. 
The potential loss is not as serious as a warning. 

 

Definition of a Warning.  

 

Definition of a Caution.  
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Safety Symbols 
Safety symbols in this manual mean this: 
 

 

Crush Point (Pinch Point) Warning 
Crush (punto de pellizco) DVERTENCIA 
Crush (Prise Punkt) Warnung 

 

Electric Shock Warning 
ADVERTENCIA de descarga eléctrica 
Elektroschock Warnung 

 

General Hazard Warning 
ADVERTENCIA de peligro general 
General Hazard Warning 

 

Noise Warning; may be over 85 db 
ADVERTENCIA de ruido; puede ser más de 85 decibeles 
Crush (Prise Punkt) Warnung 

 

Eye Hazard Warning 
ADVERTENCIA de peligro del ojo 
Auge Hazard Warning 

 

Collision Warning 
ADVERTENCIA de colisión 
Collision Warning 

 

Laser Hazard Warning 
ADVERTENCIA de peligro del laser 
Laser-Hazard Warning 

 

Compressed Air Warning 
ADVERTENCIA de aire comprimido 
Druckluft‐Warnung 

 

Electrostatic Discharge Warning (ESD) 
ADVERTENCIA de descarga electrostática 
Elektrostatische Entladung Warnung 
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Symbols for Specific Models & 
Options 

The following symbols appear in the side bar next to paragraphs or 
procedural steps that are limited to a specific model or piece of optional 
equipment. If the symbol is next to a heading, the entire content under 
that heading is limited to the equipment indicated. 

 

This Symbol 

Means… 

Adjacent information is limited to this optional 
equipment: 

 
Tape-In Module (Tape Feeder) 

 
Only Tape Output Systems 

 

Only Auto‐Tray Feeder 

 

 
Fiber Laser Marking System. 

 
FlashCORE (FC) programmers 

 
Lumen™X (LX) programmers 
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Precautions for Safe Operation 
PSV5000 has many safety features designed to make the system safe 
and efficient to operate. The system can be dangerous if the safety 
precautions and features are ignored. 

To avoid possible personal injury or damage to the equipment, observe 
the following practices: 

Precaution List 

GENERAL PRECAUTIONS 

 Do not use the PSV5000 System for any purpose other than its 
intended use. 

 Personal injury could be caused from high leakage electrical current 
from the main power cable. An Earth (ground) connection is 
essential before connecting power. 

 Do not operate the system if the safety doors and shields are not in 
their normal operating positions. 

 Do not operate the system when any of the cabinet panels (sheet 
metal) are removed. 

 Do not operate the PSV5000 System unless you have been 
thoroughly trained and have read and understand the instructions 
in this manual (or the Operator’s Manual), particularly those that 
describe the system’s safety features (Safety Systems on page 12.) 

 Do not disable or attempt to defeat any of the safety features of this 
system. Serious personal injury and equipment damage can occur if 
any safety systems are disabled. If you suspect that a safety feature 
of the system is damaged or malfunctioning, stop using the PSV5000 
immediately and contact your local Data I/O Support representative. 

 Do not place any part of your body near moving machine parts. 

REPAIR PRECAUTIONS 

 Only qualified personnel trained by Data I/O should install, 
maintain, repair, or troubleshoot the PSV5000 Systems. 

 Do not operate a system while servicing, replacing, or adjusting any 
component unless directed to do so in this manual. Make sure that 
the system is properly shut down before servicing, replacing 
components, or adjusting components. 

 Disconnect the external air before servicing pneumatic parts. 

 

WARNING: 

 

Pinch hazard. 
The E-Stop does 
not turn off air. 
Socket 
Actuators can 
still move down 
when an E-Stop 
is pushed— and 
even when 
Safety doors, are 
open. 
Use caution. 
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OPTIONAL EQUIPMENT PRECAUTIONS 

 Use extra caution when using the Tape Input module (feeder) or 
the Tape Output module options. The PSV5000 safety doors do not 
fully enclose them. It is possible that hands, hair, or loose clothing 
could get caught or pinched in these mechanisms. 

 Read and heed the laser vacuum filter disposal requirements 
described later in this section (Laser Safety on page 27). Always 
dispose of any other hazardous or residual by-products of the 
production process in accordance with governing laws and 
regulations. 

Jump Right In 

Thanks for reading about the safety symbols, notes, and icons. If your 
PSV5000 System is already set up and you want to skip ahead: 

Be safe —see Safety Systems on page 12. 

Where’s the _____? —see Machine Components on page 19 

How to run a job —see the separate PSV5000 Operator’s Manual. 

What if it stops? —see Troubleshooting on page 131 

What info is needed when I request service? -see next page. 
  

 

Basic operating 
instructions are in a 
separate manual in hard 
copy format as well as 
PDF on the Handler 
computer. 
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Contacting Data I/O 
Contact Data I/O for technical assistance visit www.dataio.com and click 
the Technical Support button. Log-in to our Support Portal. For first 
time use, we recommend that customers enter a generic user name and 
email for a distribution group so that multiple people in your company 
can access Data I/O Service requests. 
To help us give you quick and accurate assistance, please provide the 
following information: 

Machine serial number 
•  TaskLink and CH700 software version numbers 
• Job Runner or Job Creator software version numbers if applicable 
• Type of programmer (FlashCORE or LumenX) 
•  Detailed description of the problem you are experiencing 
•  The event log from the FlashCORE programmer site 
•  Error messages (if any) 
•  Device manufacturer and part number (if device related) 

Note: For later versions of this manual, check our website Technical 
Library. 

Data I/O Customer Support 

The best way to contact technical support is by logging in to our 
online Support Portal: visit www.dataio.com and click the Technical 
Support button. 

WORLDWIDE: WWW.DATAIO.COM 

Data I/O Corporation Redmond, WA USA 98052 
Telephone: +1 425-881-6444  in USA: 1-800-3-DATAIO 
Fax: +1 425-867-6972 
email: support@dataio.com (our Support Portal, above, is preferred) 

CHINA: WWW.DATAIO.CN 

Data I/O Co. Ltd  email: support@dataio.com  
(our Support Portal, above, is preferred) 

GERMANY: WWW.DATAIO.DE 

Data I/O GmbH  email: support@dataio.com  
(our Support Portal, above, is preferred) 

 

For Serial Number 

location see Figure 10: 

on page 22. 

 

Want to contact Sales? 

USA–  
salesDIOAmerica 

@dataio.com 

China– 
ChinaSales@dataio.com 

Germany– 
salesgmbh@data-io.de 

http://www.dataio.com/
mailto:support@dataio.com
http://www.dataio.cn/
mailto:support@dataio.com
http://www.dataio.de/
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OTHER COUNTRIES 

Data I/O Customer Support offices around the world are staffed with 
factory-trained technicians to provide prompt, quality service. For 
warranty service, contact Data I/O Customer Support at the numbers 
listed at our Rep Search on our website. 

To find your local Data I/O representative on our website, click 
Technical support > Representative Search. 
http://www.dataio.com/Contact-Us/Representative-Search 

Warranty Information 

Data I/O Corporation warrants this product will be free from defects in 
materials and workmanship for one (1) year from delivery. 

This warranty and any third party warranties are in lieu of all other 
warranties, expressed, implied, or arising under law, including, but not 
limited to, the implied warranties of merchantability and fitness for a 
particular purpose. 

Repair Service 
After the warranty period expires, Annual Service Agreements are 
available. As the end of your warranty period approaches, our sales 
group will contact you with the Service Agreement options.  

Repairs to systems or sub-assemblies that are not on a service 
agreement will typically be charged for labor and material costs. 

For more information or to order a Service Contract, call Data I/O 
Customer Support at the numbers listed — See “Contacting Data I/O” 
on page - 6 -. 

Change of Address 

If your address has changed, please notify Data I/O Customer Support. 
This ensures that you receive information about product enhancements. 
Be sure to include the machine model and serial number.

http://www.dataio.com/Contact-Us/Representative-Search




 

PSV5000 Owner’s Manual   - 9 - 

 

 

 

 

 

 Chapter One 1 —
 

 

Introduction 
This chapter describes PSV5000 and its components, 
software, safety and room considerations. 
The Automated Programming System (PSV5000 System) is a versatile 
production programmer that handles and programs devices in 
traditional and fine-pitched packages. These include BGA, FPGA, μBGA, 
QFP, TQFP, CSP, TSOP, SSOP, SON, WSON, SOIC  

Device technologies supported include NOR and NAND Flash, Micro 
Controllers, Serial EEPROM, and the latest e-MMC memories. 

The modular design of PSV5000 creates flexibility, allowing you to 
optimize to the level of production required by your facility. 

  

 

The PSV5000 System 
refers to the machine, 
accessories, and the 
software. The word 
Machine is used to mean 
the physical machine, 
not the software. 
For example, you might 
connect an air supply 
hose to the Machine, but 
change programming 
jobs on the PSV5000 
System. 
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Snapshot of PSV5000 

 

Figure 1:  Features of PSV5000. For a more detailed image with 
components labeled, see the Operator’s Manual. For component 
descriptions see Component Descriptions on page19. 

Setting the Language 

Several other languages are available for the application interface. To 
change the language, edit the C:\CH700\winAH400.ini file as follows: 

Touchscreen monitor 
which displays real 
time processes and 
online Help. 

E-Stop button on each 
side (at front left & right 
rear). 

Replaceable 
programmer modules 

Software options 
include a Serial 
Number Server 

Built-in mounts for 
optional Tray Feeder 
and Tape Output 
Module 

Clear safety doors 
(front and back) 

Adjustable feet for 
leveling, and wheels 
for ease of setup and 
relocation. 

Light tower displays 
machine status 

Flexible options for 
input & output:  
• static tray, 
• automatic tray 

feeder 
• laser marking 
• tape out 

ESD ground 
connection (front) Mount for a Tape-In 

Module (Tape Feeder)  

Utility drawer  
(front and back) 
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1. Opent the ini file in Notepad or UltraEdit. (Do not use Microsoft Word 
or other word processor.)  

2. Find “Language Settings” section. 

3. Add a semicolon to the line for the current language. 

4. Remove the semicolon from the line for desired language. 

 

Figure 2:  Sample from the winAH400.ini file. The language in this 
sample is set to English. 

5. Save the file. 

6. Restart CH700 Software for the changes to take effect. 
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Left Side Right Side 

System Description 

Safety Systems 

The PSV5000 System moves devices from input media through a 
programming and optional marking process to output media for delivery 
to the next phase of the production process. The machine includes a 
grounding connection to prevent static electricity (ESD). 

The PSV5000 System has several safety systems to prevent personal 
injury and system damage. These systems include E-Stops and safety 
doors. If your system has a Laser Marking Module, it comes with a fume 
extractor. 

EMERGENCY STOP (E-STOP) BUTTONS 

Two large, red Emergency Stop buttons are located near the top of the 
PSV5000 System, one on either side of the machine. When an E-Stop 
button is pressed, the gantry stops moving immediately. See caution 
notice below. 

 

Figure 3:  Two Emergency Stop (E-Stop) buttons. 

WARNING: Shock hazard! Pressing an E-Stop button removes 
power from the motion controller (gantry) only, and power off the 

Laser Marking Module. It does not remove electrical power from PSV5000 
or any optional equipment installed. Turn the main power OFF before 
opening metal doors. 

WARNING: Pinch hazard! The E-Stop does not shut off air. 
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Socket actuators can still move down and up 

SAFETY DOOR WITH INTERLOCKS 

During operation, when the high-speed PNP head is processing devices, 
the clear plastic doors at the workspace are closed to protect operators 
from injury. Both doors have a safety interlock which stops gantry 
movement if the operator forgets to first park the PNP head. 

Normally, if the power is ON, the PNP head should be stopped in the 
park position prior to opening a safety door. 

WARNING: Possible collision hazard! The high speed and force of 
the gantry can seriously harm anyone working inside the 

workspace. When working within the machine workspace, moving the PNP 
head must be the responsibility of only one qualified individual. All others 
must stay clear of the machine controls to prevent injury to that person. 
Ensure that a job is Paused or Finished, or the system power is OFF prior to 
opening any safety doors. 

 

WARNING: Shock hazard! Opening the safety doors stops 
motion of the gantry only. It does not remove electrical power from the 
machine or any optional equipment. Turn the main power OFF for safety 
unless otherwise directed. 

 

 CAUTION: Possible product damage! Do not use solvents such as 
acetone, lacquer thinner, mineral spirits, isopropyl alcohol, or any type 

of abrasive compound on the safety doors. These products will damage the 
safety door surfaces and ESD coating, and reduce visibility of the work area. 

ELECTROSTATIC DISCHARGE (ESD) PRECAUTIONS 

Devices (integrated circuits) are very sensitive to static, and could be 
damaged by unintended electrostatic discharge while being handled. 
The most effective way to prevent damage from ESD is to make sure a 
common electric potential (ground) exists between a static-sensitive 
device or component, its environment, and the operator. 

Operators should wear an antistatic wrist strap (Data I/O part number 
440-0021-001) connected to one of the grounding connections on the 

 

Park Position: 

The spot where the head 
stops when a job is 
paused or ended (near 
the far right corner). 

 

Home Position: 

The far right corner of 
the workspace where the 
head travels to before 
each job is started. 

 

Tool Position: 
Near the safety door for 
easy access to the PNP 
head. 
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machine. The wrist strap should contain a 1–10 M-ohm current limiting 
resistor. 

HANDLING DEVICES SAFELY 

To prevent damage to device pins, use a vacuum tool, also called a 
vacuum tweezer, to pick up devices. The vacuum tool is designed to 
handle devices without damaging them. 

CAUTION: Possible device pin damage! Do not touch devices with your 
hands or any implement other than the vacuum tool. Doing so could 

damage devices with fine-pitched leads. 

To pick up a device using the vacuum tools use a squeezable air bladder 
for suction. There are a variety of models, sizes and tips. Some tips are 
replaceable.  

 

Figure 4:  A Vacuum Tweezer, Data I/O PN 565-8000-001. 

 [LASER MARKING ONLY] FUME EXTRACTOR 

Used with the Laser Marking option, the laser fume extractor removes 
harmful smoke and hazardous materials from the marking area and 
safely stores them for proper disposal. 

Note: Refer to Laser Safety on page 27 for more information. For 
maintenance, see Laser Marking Fume Extractor on page 126. 

Machine Axes 

The PSV5000 System gantry operates on three primary axes: X, Y, Z. An 
additional axis, called the R-axis (theta), is used by the PNP head to 
change device orientation (rotation). 
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Figure 5:  These axes describe motion direction on the PSV5000. 
The X-Y coordinate 0, 0 is at the left front corner. 

Basic Machine Functions 

The PSV5000 System combines a device programming system and a 
high-speed pick and place head (PNP head) to provide rapid 
programming of standard pitch devices, as well as ultra-fine pitched 
devices. 

TaskLink™, or Job Creator or Job Runner software, and Automated 
Handler software (CH700) running on the system’s Handler Computer 
direct the PSV5000 System to perform a series of processes, including 
automatic handling, programming, marking, and placement of devices 
to the output media of your choice. 

The PSV5000 System performs these basic operations when processing 
devices: 

1. Pick devices from the input media— 

The pick and place head (PNP head) unloads devices from the input tube, 
tray, or tape module. These devices are placed into programming sockets 
in all cases except when Ignore Programmers is selected, in which case the 
head takes devices directly to a different media (repackaging only) or to 
the shuttle for marking only. 

2. Process devices— 
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Devices in the programming sockets undergo any or all of the following 
processes as determined by the job. These processes are set in TaskLink: 

• Continuity check 

• ID check 

• Erase 

• Blank check 

• Program 

• Verify programming 

• Read 

• Illegal-bit check 

• Functional verification operations 

• Secure device 

• Verify options such as voltage 

 

(Optional) Mark devices— 

When available, devices that pass the programming and verification 
operations are marked at the Laser Module for identification. 

3. Load devices into the output media— 

Devices are moved by the PNP head to output media: trays, tubes, or 
tape. Devices that fail one of the programming processes are placed into 
the reject bin or reject tray. 

Input and Output Options 

PSV5000 System input and output options are: static tray (manual), tray 
feeder (automatic), tube, and tape. 

Most combinations of input and output options may be used. For 
example, the PSV5000 System can be configured with input as static 
tray and output as taped. 

Manuals for Optional Equipment 

The manuals that came with any optional equipment on your system 
contain additional, more in-depth information. Some of the manuals 
came in hard copy format with your PSV5000 System. Others are PDFs 
installed on the Handler computer. 
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Figure 6:  Some of the optional equipment manuals, from left to 
right: Laser Marker; Automatic Tray Feeder CB (Tray Stacker). 
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PSV5000 Specifications 

Specifications are without optional equipment. 

FACILITIES  
Supply Air Pressure clean, dry, oil‐free air at 5.5–

8.2 Bar (551–827 kilopascals) 
(80–120 PSI) 

Air Flow 85 liters/minute (3 CFM) 
maximum air flow 

AC Input Voltage 208–240 VAC, single phase 

AC Input Frequency 50–60 Hz 

AC Input Power (max) 15 Amps (with all options) 

 

PSV5000 DIMENSIONS  
Length, x-axis (including 

monitor)1 

130 cm (51 inches) 

Width (including monitor)1 87 cm (34 inches) 

Height: machine (doors closed) 
then add [light tower] 

153 cm (62 inches) +  

[56 cm, 22 in.] 

Weight (no optional 
equipment), approximate 

 450 kg (1000 lbs.) 

 

Environment  
Operating Temperature 

Hours required for  
temperature stabilization 

+13° to +32° C (+55° to +90° F) 

8 hours after transportation 

Relative Humidity 35% to 90% non‐condensing 

Sound level 75 dB or less 

 

OTHER  
Handler PC Operating System Windows 7 OS, 32-bit  

Monitor 15 inch TFT Touchscreen 
1 Since the monitor arm rotates, length and width dimensions can be adjusted 
inversely, up to 10 cm (4 inches). For example, if you sub‐ tract 10 cm from 
length, then add 10 cm to width. 
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Machine Components 
The PSV5000 System has many components, or subassemblies, that 
work together. Refer to the figure below to locate primary components. 

Safety Systems 

LIGHT TOWER 

Allows monitoring the status of the PSV5000 System from a distance 
while the system is processing devices. See Light Tower Interpretation in 
the Operator’s Manual for a complete description of lamp colors and 
significance. 

GANTRY 

Travels along X- and Y-axes moving the PNP head to different locations 
within the work envelope. It moves devices in four axes, 

X, Y, Z, and R. 

The PNP head uses different sized probe tips to accommodate the great 
number of device types that are available. See Installing the Correct Probe 
in the Operator’s Manual. During operation, vacuum at each probe holds 
a device. Vacuum sensors detect whether or not a device is present on a 
probe tip. 

 

Figure 7:  The PSV5000 PNP head. 

The probe picks up a device and moves it to a programming socket. To 
place devices at target locations, a probe lowers, vacuum is turned off 
and blow-off air is momentarily turned on. 
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WARNING: Collision hazard! The gantry system and associated 
components move with high speed and force, and have the 
potential to cause great bodily harm. Do not bypass the safety 
interlocks or operate the with the safety doors open or removed. 

PROGRAMMERS 

Data I/O’s FlashCORE III programming modules are used in many 
Data I/O products and have most algorithm support. LumenX 
programmers are one of the fastest programmer architectures currently 
available. Programmer Modules in the PSV5000 include pneumatic 
socket actuation. 

 

Figure 8:  Left: A FlashCORE Programmer (next to the reject bin), 
and Right: a LumenX Programmer.  

VISION SYSTEM 

PSV5000 uses an upward camera for precise picking and placing. 

STATIC TRAY MOUNT 

Using positioning pins and a magnetic bracket, JEDEC and non-JEDEC 
standard trays are held firm for the PNP head to pick devices and return 
them after processing. 
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Figure 9:  A typical Static tray installation. Note that the beveled 
corner is at the far left, adjacent to the sensor. 

HANDLER COMPUTER 

The on-board Handler computer hosts TaskLink software and the 
CH700 software, and monitors all sensors. The computer contains a 
CPU that runs Microsoft Windows 7 Operating System (at time of 
release). 

 CAUTION: Possible machine damage! Adding software to the PSV5000 
System can cause damage or cause the system to operate improperly. 

Adding software without specific instruction from Data I/O Customer Support 
will void the warranty and may incur service charges if subsequent service is 
required. 

KEYBOARD AND TOUCH SCREEN 

Both methods of input are available for operation. With the touchscreen, 
tap the screen with a finger only, not sharp objects such as pens or 
pencils. 

Note: Throughout this Owner’s Manual, the term click is also used to 
mean tap when using the touch screen monitor. 

ESD STRAP CONNECTION 

When operators plug an antistatic wrist strap into the ESD strap 
connection, it reduces the risk of damage to devices and Socket Adapters 
from electrostatic discharge (ESD). 
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SAFETY DOORS 

Designed to protect against injury and damage from the PNP head 
movement, the safety doors are an important safety feature, stopping the 
gantry when they are opened. 

For more information see Safety Door with Interlocks on page 22. 

POWER PANEL 

The Power Panel is on the lower left side of the machine. 

CONNECTIONS 

The Power Panel allows for the attachment of AC power and air. 

Optional connections: 

You can connect an Ethernet cable for internet connection 

CONTROLS 

Mounted on the Power Panel are the main power switch and the main air 
regulator and filter. There is a second regulator with a separate gauge for 
adjusting socket opener pressure. See Adjusting the Socket Actuator Air 
Pressure on the Programmers on page 99. 

 

Figure 10:  Power Panel (Facilities Panel) on the back of the machine. 
The Serial Number is there, also (arrow). 

Optional Equipment Descriptions 

CIRCUIT BREAKERS 

There is a toggle switch on the power panel which allows shutting off 
power to only the programmers. 
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Numerous hardware options can be purchased with PSV5000, most of 
which are the various input and output modes. The non-input/output 
option is laser marking for devices. 

LASER MARKING DEVICES 

The Laser Marking System uses a compact Laser to mark devices. The 
laser applies a customer-defined mark. MarkingMate is supplied with 
the laser for creating marking files. The laser marking system operates 
as a Class 1 laser system, with a class 4 embedded laser (CDRH 
classification), and therefore uses integrated interlocks to prevent the 
laser from firing while any cover is open. The laser should never be 
operated without safety covers in place. Observe all warnings regarding 
laser usage. 

For additional safety information, see Laser Safety on page 27. 

(OPTIONAL) AUTOMATIC TRAY FEEDER 

Designed to automatically supply trays full of devices to the PSV5000 
System, the Tray Feeder CB accepts up to twenty thin or thick JEDEC 
trays. 

 

Figure 11:  The Tray Feeder. 

(Optional) Tape Input Module 
The tape input module is a mount and communication accommodating 
a chip feeder which provides devices for programming. Use the 
appropriate size tape width/feeder. Each device is picked from a carrier 
tape pocket and placed into a programming socket. 
 

(Optional) Tape Output Module 
The tape output module, mounts onto the left side of the machine and 
uses a reel of empty carrier tape to hold devices after they are 
programmed. It supports all widths. Programmed devices are placed into 
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empty pockets on the carrier tape. The carrier tape advances through 
either a heat seal or pressure seal unit that applies cover tape to the 
carrier tape. 
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Software 
Software resides in the Handler Computer. The primary log-on for the 
Handler Computer is Microsoft Client. The current operating system (at 
time of this publication) is Windows 7. 

 CAUTION: Possible machine damage! Adding software to the 
PSV5000 System can cause damage or cause the system to 

operate improperly. Adding software without specific instruction from Data 
I/O Customer Support will void the warranty and may incur service 
charges if subsequent service is required. 

 

CAUTION: Possible machine damage! Microsoft Windows system 
parameters and network parameters should not be changed 

unless instructed to do so by Data I/O Customer Support. Changing 
parameters can cause failure and/or damage to systems or cause improper 
programming. 

SUPPLIED SOFTWARE 

The PSV5000 System should never have other software added without 
consulting with Data I/O Customer Support. 

ANTIVIRUS SOFTWARE 

Customer-supplied antivirus software can be installed on the Handler 
Computer and is recommended. 

CAUTION: Possible loss of support or time! Check with Data I/O 
Customer Support to ensure that your software is compatible with the 

programming system, otherwise the warranty may be voided.  
Ensure that the antivirus software does not scan during a job run. 

STATISTICAL PROCESS CONTROL SOFTWARE 

Customer-supplied Statistical Process Control software can be installed 
on the Handler Computer. See Statistical Process Control Software on 
page 73 for more information. 
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Job Creation Software for FlashCORE 

TaskLink™ for Windows®
 is Data I/O’s versatile application for creating 

jobs to run on the PSV5000 System with FlashCORE programmers. 
TaskLink resides on the Handler Computer. 

 

Figure 12:  TaskLink’s main window displays the selected 
programming system. Jobs created or edited will be for this 
system. 

TaskLink online Help is available by clicking Help > Help Topics. It offers 
procedural steps as well as general information. 

 

Figure 13:  TaskLink online Help. It includes update instructions. 

Job Creation Software for LumenX 

Job Runner and Job Creator are Data I/O’s latest applications for 
creating and managing jobs to run on the PSV5000 with LumenX 
programmers. The software resides on the Handler Computer. 

Updates and Algorithm Support 

Updates, includes algorithm updates, are generally acquired through 
our APS Agreement (Annual Programmer Support). See APS Agreement 
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on our website under the SUPPORT tab. For more information, see 
TaskLink online Help or Job Runner/Job Creator online Help. 

 

CH700 Application 

Data I/O’s Automated Handler software is a Microsoft® Windows®-based 
application for setting up and programming integrated circuits (devices) 
on PSV5000 Systems. It offers a selection of many PSV5000 System 
options such as input/output configurations, labeling options, and 
statistical feedback methods. The CH700 application software resides in 
the Handler Computer. 

For updates to CH700 Software see Software and Firmware on our web 
site under the SUPPORT tab. Then look for PSV5000 under Download 
the Latest Firmware. 

Figure 14:  CH700 Start-up window for PSV5000. 

Laser Software 

The Laser software is a Windows-based application that allows creating 
parameters required for laser marking jobs as well as initiating laser 
marking. This MarkingMate software is on the Handler computer. 

When the Laser Marking System is set up and initialized, it receives 
commands from the CH700 which starts the marking sequence. 

For more information please refer to the MarkingMate software help. 

Laser Safety 

The PSV5000 Laser option is designed in accordance with the following 
safety guidelines: 

 

For more information 
about the Laser System, 
see Setting Up the Laser 
Marking Module on page 
55 and (Optional) 
Creating a Laser Marking 
File on page 81. 

http://www.dataio.com/Support/SoftwareFirmware.aspx
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• A fume extractor traps marking fumes and other by-products of the 
laser marking operation. 

• The system designed to comply with Complies with ANSI, IEC, and 
CDRH guarding standards. 

• Refer to and follow laser and safety precautions in ANSI Z136.1 - 
2007, American National Standard for the Safe Use of Lasers. 
Procedures listed under the Standard include: appointment of a 
Laser Safety Officer, operation of the product in an area of limited 
access by trained personnel, servicing of the equipment only by 
trained and authorized personnel, and posting of signs warning of 
potential hazards. 

WARNING: Possible eye and skin injury! The laser will fire even 
when safety doors are open. If equipped with Laser Marking, do 

NOT interfere with, or work on, the Laser Module while the Laser PC 
key-switch is ON. 
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Room Consideration 
When planning the space and environment for a PSV5000 machine 
installation, consider ventilation and access for maintenance and 
repair. 
Summary-Regarding ventilation, the minimum room size for any 
PSV5000 System is 3 x 3 meters x 2.4 meters high (10 x 10 x 8 feet). 
However, access space for some machines requires a larger room; 
see Access Space below. 

The PSV5000 System, and its optional components, such as a Tape 
Output System or Automatic Tray Feeder, contains mechanical 
components and electrical systems that generate heat and 
extremely low levels of particulate matter. 

The room should have suitable levels of general room heating, 
ventilation, and air conditioning. For an occupied office area, the 
American Society of Heating, Refrigeration, and Air Conditioning 

Engineers, Inc. (ASHRAE) Standard 62-1992 specifies a minimum 
of 15 cubic feet/minute (CFM) (0.424 cubic meters/minute) of air 
per occupant. This level of ventilation is intended to provide the 
occupants of the room with sufficient air movement to provide a 
comfortable environment. 

However, because the PSV5000 System generates heat, an 
additional 85 CFM (2.40 meter3/minute) is recommended, bringing 
the total room air exchange rate to 100 CFM (2.83 meter3/minute). 

In a room with dimensions of 10 feet by 10 feet, with an 8 foot 
high ceiling (800 cubic feet of total interior area), 100 CFM would 
provide approximately six room air changes per hour. (Metric room: 
3.0 M x 3.0 M x 2.4 M high ceiling equals 22.65 cubic Meters of 
total interior area). 

Based on industrial hygiene monitoring performed during the worst 
case operating scenario of a PSV5000 System, this rate of air 
movement is sufficient to provide a safe and healthy work 
environment regarding air quality. 

Access Space 

The PSV5000 Machine should be located in a room with adequate 
space to allow easy access to all enclosures. 

 

The air movement is 
intended to dissipate 
heat, odors, and other 
exhalation products 
from respiration such as 
carbon dioxide and water 
vapor. 
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THE INTENDED AREA FOR INSTALLATION MUST: 
• allow at least one meter (39 inches) of clearance on all sides of the 
machine for opening access panels as well as repairing and 
replacing subassemblies, 

• provide a solid foundation (for example, a concrete floor). The 
machine contains a fast-moving gantry with much mass. The area 
for it must be stable, solid, and mostly level prior to installation. If 
this is not achievable, consider installing the system at another 
location. 

The table below lists recommended, minimum envelope size 
determined by the 1 meter access space required on each side: 

MINIMUM PHYSICAL ENVELOPE 

Note: The numbers below do not include ventilation requirements 
discussed in the previous heading Ventilation. 

 

Machine 
Configuration 

 

Width x Depth 

(X-axis x Y-axis) 

Width x Depth 

+ 1 m all sides 

for access 
PSV5000 Only 1.5 m x 0.87 m 3.5 m x 2.87m 

PSV5000 + Laser 1.3 m x 0.87 m 3.2 m x 2.87m 

PSV5000 + Tray Feeder 2.1 m x 0.87 m 4.1 m x 2.87 m 

PSV5000 + Tape Out 

Module with Large reel 

2.2 m x 0.87 m 4.2 m x 2.87 m 

PSV5000 + Tray Feeder 

+ Tape Out Module with 

Large reel 

2.9 m x 0.87m 4.9 m x2 .87m 

 
For example, a PSV5000 System with a Tray Feeder requires a 
minimum physical area of 4.1 meters wide x 2.87 meters deep for 
easy access. 
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Figure 15:  Maximum envelope of PSV5000 without optional 
equipment such as marking, Tape-In or Tape Output Modules. 
(Dimensions in mm. Reduced scale). 
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Setup 
This chapter covers setting up the PSV5000 machine as well 
as setting up equipment on the machine. This includes 
optional equipment such as the Tape Output equipment, as 
well as the various device media choices for running jobs, 
such as setting up Static Trays or an Automatic Tray Feeder. 

Machine Installation 
Installation of the PSV5000 is performed by Data I/O service personnel 
or an authorized distributor. After the PSV5000 arrives, ensure that 
there is no damage to the exterior of the crate. Remove the PSV5000 
Machine from the crate and inspect for damage that may have occurred 
during shipping. If no damage is evident, unbolt the machine from the 
shipping pallet. 

For the intended area for PSV5000 installation see Room Considerations 
on page 29. 

Leveling 

When the PSV5000 is at the desired location, adjust the feet to level it. 

 WARNING: Possible machine damage or personal injury! 
Instability such as vibrating, walking, or rocking, may occur if 
fewer than four of the installed feet make suitable contact with 
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the floor, or if the leg locknuts are not tightened against the frame. Only the 
adjustable feet provided on the PSV5000 Machine should be used for 
leveling. Do not use shims to assist in leveling. 

Connecting Facilities 

The PSV5000 requires two external services: pressurized air and 
electrical power. It also allows one optional connection to an Internet via 
a Network connection. These services connect to the PSV5000 Machine 
at the Power Panel located on the back of the machine. 

With the two required services, the machine creates all the unique 
electrical voltages needed as well regulating pneumatic pressure for all 
systems within the machine. 

Connecting Air 

The machine requires clean, dry, oil-free air from an industrial grade 
compressor. 

 
PSV5000 Air Requirements Table 

 

Note: If the compressor cannot maintain the correct air pressure and 
stable air volume, PSV5000 System performance will be affected and may 
damage devices. 

 

 
 

System 

 

 
 

Air Volume 

@ Air 
Pressure 
at inlet 
regulator 
on 
PSV5000 

 

 
 

Supply Air 

 
Min. 
Air 
Tube 
Length1 

 

 

Customer supplies a 

primary 

filter/regulator 

required between 

factory compressor 

and PSV50002 

—Metric 
 

 
 

 

85 L/minute 
[.084 m3/min], 

t t 

5.5 ±0.3 Bar 5.5 ‐ 8.2 Bar 3 Meters 10 micron 

3 SCFM constant 80 ±5 PSI 80 to 120 PSI 10 Feet 10 micron 

1 This external air line must allow the supplied air to cool sufficiently so that water vapor in 
the air condenses and can be extracted. 

2The air filter on the Facilities Panel is a secondary filter only. 
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Figure 16:  Power Panel on the back of the machine. 

Connect air to PSV5000 at the main regulator and filter. See the figure 
above for the location of the external air line connection. 

 CAUTION: Possible air system damage! Oil, excessive moisture, or 
poorly filtered air will obstruct the system’s internal air pathways, 

affect performance, and void the warranty related to air system failure. If oil or 
excessive moisture is detected, contact Data I/O Customer Support or a local 
Data I/O approved service representative. 

MAIN AIR PRESSURE GAUGE 

The main pressure regulator is set at the factory, but can be changed 
manually. See Connecting Air on page 34 for the factory setting. 

When air pressure is within range, the regulator readout is green. If air 
pressure is above or below the acceptable range, the readout displays red. 
If it is red (out of range), contact Data I/O Support or a qualified service 
technician. The upper and lower limits cannot be changed without the 
password. 

Connecting Electrical Power 

WARNING: Electric shock hazard! Personal injury could be 
caused from high leakage electrical current from the main power cable. An 
Earth (ground) connection is essential before connecting power. 

Required power is provided through a supplied 3-wire power cable with 
one end terminated in an electrical plug as required by the customer’s 
facility. For power specifications, see PSV5000 Specifications on page 18. 
For cable location see Figure 35. 

Main regulator 
and filter 

Socket Opener
Pressure Control 

Programmer Power 
Toggle (up is ON) 

Main Power Switch 
(Lockout capable) 

Air Shut-off 
valve 

Ethernet 
connection 

Power Cable (does not 
disconnect here) 

Air Connection 

 
If there is low air 
pressure the monitor 
may display a message 
reading No air. 
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(Optional) Connecting an Ethernet Cable 

A Network connection is on the Power Panel. Plug in an Ethernet cable. 
Refer to Figure 2-1. 

Network settings are described in (Optional) Network Settings on page 38 

CAUTION: Possible PC virus hazard! The PSV5000 System has no 
antivirus software installed from the factory. Prior to connecting to a 

 network, Data I/O recommends installing antivirus software. 

To install antivirus software refer to (Optional) Installing Antivirus 
Software on page 38.  



■ Applying Power for the First Time □ (Optional) Connecting an Ethernet Cable 

PSV5000 Owner’s Manual   - 37 - 

Applying Power for the First Time 
Before the PSV5000 System is turned on for the first time, ensure the 
following: 

 The external air line is connected, and the main air valve is open. 
 All E-Stop buttons are in the released (operating) positions (refer to 

Emergency Stop (E-Stop) Buttons on page 1-4 for location). 
 All safety doors and access doors are closed. 
 The programmer power toggle switch on the Power Panel is ON (UP) 

position. 
 The power switch on the Handler Computer is set to the ON position 

(although it will not have power 
yet). The rocker switch is ON when 
tipped to the down position. 

 (Optional) The Socket Adapters 
required for the job have been 
installed on all necessary programmer sites. See Installing Socket 
Adapters in the Operator’s Manual for more information. Note that 
Socket Adapters can also be installed after power is on. 

 Note: To tighten socket adapters/boards, the recommended torque 
range for FlashCORE programmer screws is 1.4 – 1.5 Newton Metre 
(Nm)/12.4 – 13.3 pound force inch (lbf-in). 

When satisfied, rotate the main power switch on the Power Panel to the 
ON position (clockwise). 

After power is applied, verify that no obvious failures or electrical 
anomalies occur. Verify that the Handler Computer starts properly and 
displays a network log-on dialog. 

Note: If electrical or mechanical problems are noted, turn OFF the 
PSV5000 System and notify Data I/O Customer Support. 

At the Microsoft Log-on window, click the user profile (usually labeled 
MFG) to complete the startup procedure. 
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Shutting Down the PSV5000 System 

1. Finish and Exit any job that is running. 

2. (Optional) Remove all devices from the system. 

3. Exit CH700 and TaskLink and any other software that you have 
running. 

4. Shut down the Handler Computer PC with the Windows Start 
menu. 

5. (Optional) Save and exit the Laser Marker software. 

6. (Laser Option) Turn OFF (0) the key-switch (counterclockwise) on 
the laser PC. 

7. WAIT UNTIL WINDOWS COMPLETES SHUTTING DOWN, then 
rotate the main power switch (on the Power Panel) 
counterclockwise to the OFF (vertical) position. 

If the PSV5000 Machine will not be used for several days, the shop air 
should also be removed or turned off at the Power Panel. (Optional) 
Padlock the main air pressure valve so that it cannot be turned back ON 
while the lock is in place 

(Optional) Installing Antivirus Software 

The PSV5000 System has no antivirus software installed from the factory. 
It is highly recommend that customers install their own antivirus 
software. The software should be set to run virus scans manually rather 
than at a scheduled time unless you are sure that the PSV5000 System 
will not be running jobs at that time. 

Note: An antivirus program may affect performance. 

The PSV5000 System runs Windows 7 Professional 32-bit operating 
system. Follow instructions for your antivirus software. Contact Data I/O 
Service with specific questions. See Contacting Data I/O on page - 6 - (in 
Preface). 

 (Optional) Network Settings 

After starting up the PSV5000 System and logging on, double-click 
Computer > Map Network Drive (Windows 7). 
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IP ADDRESS AND PORT NUMBER 

If you need the IP Address for communicating with other Data I/O 
software, they are available via TaskLink. The Port numbers are also 
displayed. (Port numbers are the same for all programmers on a PSV5000 
Machine.) 

Addresses and Port numbers can be found as follows. 

1. Start TaskLink on the target PSV5000 System. (Closing CH700 
will return to TaskLink.) 

2. Click System > Options > Communication tab. The IP Address 
and site numbers are listed in the lower left corner. 

 

Figure 17:  TaskLink Communication Tab displays IP Addresses and 
site numbers. 
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Setting Up Input and Output 
Media 

There are many options for device input and output. One option for 
input and one for output must be set up on the PSV5000 Machine for 
your target job. Further, the setup must correspond with the current 
software, such as the Job file, winAH400.ini file. 

These input/output media are described in this section: 

• Static Tray (below) 
• Reject bin 
• Auxiliary tray 
• Automatic Tray Feeder, page 43 
• Tape Output Module, page 47 

Note: The Tape Input feeder installation is covered in the PSV5000 
Operator’s Manual. 

About Static Tray Input and Output 

The standard configuration for the PSV5000 System is static tray input 
and static tray output media. The latest tray mounting configuration 
uses two rows of locating pins and a magnet. Specific steps for installing 
trays are described in the PSV5000 Operator’s Manual. 

Note: Make sure that the correct devices for the target job are loaded into 
the input tray and that they have the correct pin 1 orientation. (If pin 1 
orientation doesn’t match pin 1 that is set in the Package File it must be 
corrected). Pin 1 on Data I/O sockets is almost always toward the far side 
of the Socket Adapter (the back of the machine). 

Remember that tray arrangement affects: 

• The Setup window > Options tab which must be set to match the 
workspace setup (covered in the Operator’s Manual). 

• The Package File which must be taught the Tray locations (covered 
later in Chapter 3 of this manual). 

REMOVING TRAY PLATFORMS 

Static Tray Platforms can be removed to support different mediums such 
as to install an automatic tray feeder. 

 
Note that the work 
surface layout is 
affected by what 
programmer models 
are installed. 
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REQUIREMENTS 
Metric hex key set. 

To remove a Static Tray Platform: 

1. Shut OFF the PSV5000 System. See Shutting Down the PSV5000 
System on page 38. 

2. Disconnect the tray sensor- 

2a. Remove two sensor bracket screws (2.5 mm). 

2b. Lift the bracket up and remove the two screws securing the 
sensor to the bracket (1.5 mm). 

Note: Best practice is to re-attach the sensor screws to the bracket, and 
the bracket to the platform so parts don’t get lost. 

3. Open the front or back lower access door and remove four screws 
from the target Static Tray Platform (3 mm hex key). 

Figure 18:  Static Tray Sensor and bracket. Two bracket screws 
shown (at B). Only one of the sensor screws is visible (arrow). 
(This image is for reference only. Yours may not be positioned 
like this.) 

4. Move the sensor into the bottom side of the machine through the 
sensor cable hole in the working plate. Tie it carefully to the cable 
way. 

To re-install the platform, reverse the steps for removal. 

Install the Reject Bin 

Install a reject container for devices failing any process. Many workspace 
layouts are possible. Generally, a reject bin (or box) is placed on the front 
left of the workspace as shown in Figure 2-5, on top the Tape Input 
media exit chute. However, a box or pad can be placed wherever there is 
room for it as long as its location is taught in the Package File. 
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Figure 19:  Common locations for the reject tray and bin with Tape 
Input and Tape Output. Only one is necessary. The reject bin 
that comes with the PSV5000 should be placed as shown. 

Note: On the Gantry window, the reject bin or tray is associated with a 
yellow position label that reads RTr. 

The reject bin just lifts in and out by hand. 

A tray may be used as a reject container instead of a bin. 

Auxiliary Tray 

If a reject tray and an auxiliary tray is used as shown below, the 
mounting plate for the Tape-In Module must be removed as well as the 
mounting bracket for the reject bin. Contact Data I/O Support for 
instructions.  
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Figure 20:  Two possible workspace configurations with trays on the 
left. A reject tray and an auxiliary tray with Auto Tray Feeder 
(top) and a Tray to Tray with a reject bin (trays not shown) 
(bottom). Two tray mounts must be installed on the left for these 
configurations. 

Setting Up an Automatic Tray Feeder 

The PSV5000 System can be configured with an Automatic Tray Feeder. 

The Tray Feeder must be level to the Gantry and square to the PSV5000 
Machine. For general information about setting it up, see the Tray 
Feeder Owner’s Manual that came with your system. Look for the 
heading Installation. 
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Prior to editing the 
winAH400.ini file, make 
a backup copy.  

 

Figure 21:  Tray Feeder mounted on PSV5000. 

The winAH400.ini file requires editing prior to using a Tray Feeder if 
your PSV5000 Machine has not already been set up for one at the factory. 
See the CH700 on-screen Help file for topic Editing the winAH400.ini file. 

Note: When your winAH400.ini file is set to run an Automatic Tray Feeder, 
before you can run static trays again, the file will need to be changed back 
to ModelTray1=STD. 

INSTALLING THE TRAY FEEDER 

The Tray Feeder can only be installed if your PSV5000 was set up for it at 
the factory or by a Data I/O Service Technician. 

REQUIREMENTS 
• Two people to lift it 

• Metric hex key set 

• Key to access door 

 

To install the Tray Feeder: 

1. Shut OFF PSV5000 power. See Shutting Down the PSV5000 System 
on page 38. 

2. Remove the Input and Output static tray mounts, if installed.  
Refer to Removing Tray Platforms on page 40. 

3. On the right side of the machine, locate the clear rectangular shield 
covering the Tray Feeder opening and remove the left screw with a 
4 mm hex key. 
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Figure 22:  The safety shield for the Tray Feeder has been rotated 
out of the way and fastened in the ‘storage’ position with the two 
screws (arrows). 

4. Loosen the lower right screw. 

5. Rotate the shield up 90° clockwise and fasten in place at the extra 
hole with the screw removed earlier. 

6. Get the Tray Feeder fasteners ready, and a 5 mm hex key. 

CAUTION: Heavy equipment! The Tray Feeder weighs  30 kg (66 lb.). 
Two people are required to lift it. A third person is needed to attach 

fasteners. Use caution.  

7. With two people lifting the Tray Feeder, slide the nose into the shield 
opening and far enough in to accommodate the mounting holes on 
the machine base plate. 
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Refer to the following 
figure for Tray Feeder 
connections. 

 

Figure 23:  The Tray Feeder mounting screws (arrows). There are 
also two fasteners on the back side of the feeder (not shown). 

8. Screw in a screw into each of the four mounting holes to secure the 
feeder (5 mm hex key). 

9. Plug in the three utilities: air, electrical, signal cable.  
The air connection has One-Touch fittings.  
The electrical connector can be rotated until it slides into the socket, 
and then screw the knurled ring up. 
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Figure 24:  Connection for the Tray Feeder: air, electrical and signal 
(left to right). 

Very basic operating instructions are covered in the PSV5000 Operators 
Manual. Complete instructions are covered in the Tray Feeder Manual. 

TRAY ARRANGEMENTS 

You can use a spare tray with an Automatic Tray Feeder (ATF). When a 
spare static tray is designated, the devices from that spare tray are used 
to replace rejected devices. They are also used during a tray change. 

Either a reject tray or bin is also required.  

Remember that: 

• the Setup window > Options tab must be set to match the 
workspace setup (covered in the Operator’s Manual). 

• The Package File must be taught the location of the reject 
container (covered in Chapter 3 of this manual). 

• (Optional) If the Sort-On-Error-Code is used, two Reject Bins are 
required. Set up for Sort-On-Error-Code by installing a second 
reject bin. 

The Tape Output Setup and Operation 

The PSV5000 System can be configured with an optional Tape Output 
System. 

The Tape Output System receives programmed devices directly from the 
PSV5000 System via the PNP head. The Tape Output System advances 

 
For more about 
Sort-On-Error-Code, see 
Monitoring Statistics on 
page 71. 
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the carrier tape through a mechanism that seals the tape (using heat or 
pressure), and rolls the filled tape onto a reel for delivery to the next 
stage in the manufacturing process. 

 

Figure 25:  Tape Output Module on PSV5000 

Note: For additional information, refer to the TM-50 Tape Output System 
User’s Guide that came with your Tape Output System. 

INSTALLING THE TAPE OUTPUT MODULE 

TOOLS REQUIRED 
• Metric hex key set 

• Three people to lift / install the Tape Output Module 

These steps are for installing the Tape Output Module (which can be 
ordered with the PSV5000). 

1. On the left side of the machine prepare the small clear safety covers 
for receiving the Tape Output Module. 

a. Loosen the screw on the lower left of a rectangular safety 
shield shown in Figure 2‐14 (4 mm hex key). 

b. Unscrew the top screw (4 mm hex key). 
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c. Rotate the rectangular shield counterclockwise 90°to the 
‘storage’ position and screw it to the fixed safety shield with 
the screw you just removed. Refer to the figure below. 

 

Figure 26:  To install the Tape Output Module, Shield rotates 
counterclockwise 90°. 

2. Unscrew the five screws that secure large fixed safety shield (4 mm 
hex key). 

WARNING: Possible injury or property damage! The Tape Output 
Module is heavy. Use caution. Two people are required to lift this 

equipment. Approximate weight: 47.63 kg (105 lbs.). A third person may be 
required to bolt it into place. 

3. Install the Tape Output Module onto the plate in the PSV5000 
workspace and screw it down with six screws (5 mm hex key). See 
the figure below. 
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Figure 27:  Tape-Output Module mounting screws (circled). Three 
more mounting locations are on back side (hidden in this view). 
Ref: The Tape-In mount and chute are in the foreground. 

SETTING UP THE TAPE OUTPUT MODULE 

CAUTION: Possible tape damage from excessive heat! Improper routing 
of the device tape may cause enough heat to melt the tape. Ensure the 
correct routing path is followed. See the TM-50 Tape Output System 

User’s Guide. 

To set up the Tape Output System: 

1. Edit the winAH400.ini file for Tape Output— 

1a. Using Windows Explorer, locate C:\CH700\winAH400.ini 
and make a backup copy, for example, 
winAH400backup.ini. 

1b. Open the original file with Microsoft Notepad. 

1c. Locate the line: TapeOutPutInstalled=FALSE and change it 
to True: TapeOutputInstalled=TRUE 

1d. Save the winAH400.ini file and exit Windows Explorer. 

2. The Tape Output Module gets power and air from the PSV5000 
System. Connect the compressed air, electrical power, and 
communication (Just right below the Tape Output System). 

3. Ensure the PSV5000 System air is connected and power is ON. 

4. Switch the Tape Output Module ON by pressing the power switch.  
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5. Set the taping job parameters at the controller. For more 
information see the TM-50 Tape Output System User’s Guide. 

6. Pull the nearest half of the track (table) out to the desired track 
width. It stops at detents set to specific tape widths. 

7. Mount the carrier tape reel— 

7a. Remove the carrier tape quick lock from the carrier tape 
spindle. 

Figure 28:  Removing the spindle. 

7b. Mount the bulk carrier tape reel on the right spindle so the 
tape unwinds from the top. 

7c. Replace the quick lock. 

7d. Trim the end of the carrier tape so it is clean and straight. 

8. Route the carrier tape— 

8a. Guide the carrier tape into the loading track. It should feed 
right to left through the loading track easily. 

Note: Lowering the feed reel support arm can reduce drag if the angle at 
which the carrier enters the loading track is too steep. 

8b. Bring the end of the carrier tape past the sealer and engage the 
sprocket holes on the teeth of the drive sprocket. 

9. Mount the cover tape— 

9a. Place a reel of cover tape of the correct width to match the 
carrier tape on the cover tape spindle. The tape should 
unwind to the right from the bottom of the reel. 

9b. Set the width of the cover tape guide assembly for your size 
tape. 
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9c.  Use the Cover Tape Position Adjuster if needed. Turning it 
clockwise moves the cover tape position toward the sprocket 
side of the tape. 

9d. Using blue tabbing tape, attach the cover tape to the carrier 
tape. Thread both through the cover tape Guide Sealer 
Assembly. Run the machine to advance the carrier and 
cover tapes through the sealer. 

 PREPARE THE SEAL 

Note: Disable the pressure seal by loosening the seal roller pressure 
screws until the seal rollers are no longer in contact with the cover tape.  
 
Normally the heat switch is in on position. If not, turn on the heat switch. 

To prepare the heat seal  

1. Set the temperature controls to the appropriate temperature. See 
the table below. 

 

Carrier Tape Type  Cover Tape Type  
Temperatur

e  
Air 

Pressure  
Dwell Time  

3m Type 3000  
Conductive Carrier 

 
 

3m Type 2675 Static 
Dissipative Cover 

 
 
 
 

 

 

135-155°C 
 

 
 
 
 

 

 

40-60 PSI 
 

 
 
 
 

 

 

250-400 ms 
 

3m Type 2701/2703 

Non-conductive 

Advantek 

Conductive 

Advantek Type AA 

Advantek  

Non-conductive 

 Advantek Type S  

Figure 29:  This table lists suggested temperature and pressure 
settings for the Tape Output. The temperature of each shoe can 
be increased or decreased according the results of a peel force 
test. 

2. Adjust the heat shoe air pressure to the appropriate setting. This 
setting controls the amount of force applied when the sealer shoes 
drop. 
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Note: The recommended starting point for heat shoe air pressure is 50 PSI. 
Turning the heat shoe adjuster clockwise increases the pressure. 

3. After the heat sealer reaches operating temperature, set the 
controller parameters, if not already set. 

4. Press Start in the LCD. 

5. Advance the tape using the Manual Trig button in the LCD. 

6. Check the sealed tape for the desired sealed position. 

7. If necessary, adjust the inner seal position by turning the inner 
seal adjuster (thumb wheel) clockwise (to move the seal away from 
the operator) or counterclockwise. Tighten the position lock to 
secure it. 

8. If necessary, adjust the outer seal position by turning the outer 
seal adjuster (thumb wheel) clockwise to move the seal toward the 
operator or counterclockwise (to move the seal away from the 
operator). Lock the adjuster into place using the position lock 
knob. 

 

 For Pressure Seal (PSA) 
1. To prepare the pressure seal. Set the temperature to Room 

Temperature, 25℃ .  

2. Advance the tape using Manual Trig button in the LCD. 

3. Adjust the inner and outer seal roller position. Align the roller 
position over the strip of adhesive on either side of the PSA cover 
tape. Both thumb screws have locking devices. 

4. Adjust the pressure at both sealer wheels to free spinning and then 
1/8 revolution tighter. Use a 2 mm hex key. 

5. Advance the tape using the Manual Trig button in the LCD. 
Re-adjust the seal roller pressure until the PSA adhesive is firmly 
adhered to the carrier tape. 

Note: Excessive roller pressure may cause carrier tape advance problems 
or elongation of sprocket holes in the carrier tape. 

CHECKS TO PERFORM PRIOR TO RUNNING 

6. Mount an empty take-up reel on the spindle. 

7. Perform a Peel Force Test Perform as many peel force tests as 
needed while adjusting the sealer controls to obtain the required 
seal strength. 
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Remember: when the 
reel is being taped on 
the TM-50, the trailer 
will be the first length 
of empty carrier tape 
run before the first 
device is taped, and 
the leader will be the 
length of empty 
carrier tape run after 
the last device is 

 

8. Create the Trailer and Leader Before beginning a production reel, 
determine how long the trailer and the leader should be. Run out 
enough sealed empty pockets to make the trailer that is required 
for the current job. 

9. Check Carrier Tape Alignment To ensure an accurate count, select 
a spot on the loading track as a reference point for the first and last 
devices counted. 

10. Set the Counter Set the counter STOP value in the LCD to a big 
number as 9,999. 

Note: Use the counter on the Tape output system if desired. However, we 
recommend setting this counter to zero and using the pass quantity on the 
PSV5000 System to monitor quantity. 

Note: When starting a job that uses Tape Output, pull the red “E-Stop/On” 
button on the taping machine to start it. 

PLACING DEVICES 

Devices are placed by the PNP head when your job is run. 

ENDING A TAPED RUN 

See the PSV5000 Operators Manual or the TM-50 Tape Output System 
User’s Guide. 

REPLACING A FULL TAKE UP REEL 

See the PSV5000 Operators Manual or the TM-50 Tape Output System 
User’s Guide. 

REMOVING A TAPE OUTPUT MODULE 

Removal of the Tape Output Module is in the reverse order of installation. 
See the instructions above. 
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Setting Up the Laser Marking 
Module 

Preparation: 

1. Make sure a USB dongle for the laser has been updated. 

2. Upgrade CH700 to V2.3 by installer. 

3. Copy CH700.exe (v2.3.2) from \\sol\ProjDocs\PSV5000 - 
1071\Software\CH700 v2.3.2 to C:\CH700 to replace exe of v2.3. 

4. Update below values in the package file 

5. #134    1500       MSEC, LASER SHUTTLE MOVING TIME 

6. #137    0          NUM, INCREASE OR DECREASE LASER 

POWER OF CUP2 BASED ON CUP1 

7. #138    0          NUM, DISTANCE BETWEEN CUP1 AND 

CUP2 IN X DIRECTION                                            

8. #139   -42000      NUM, DISTANCE BETWEEN CUP1 

AND CUP2 IN Y DIRECTION 

5. Start ‘MarkingMate.exe.’  

6. Click a blank space on work area, and then at the Property Table, 
click Work Area tab, and click Lens Correction to open the Lens 
Setup dialog. 

file://sol/ProjDocs/PSV5000%20-%201071/Software/CH700%20v2.3.2
file://sol/ProjDocs/PSV5000%20-%201071/Software/CH700%20v2.3.2
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Figure 30:  The Lens Correction button in the MarkingMate software. 

7. Confirm scale settings are the same as shown in Figure 32: below. 
They are system values: confirm or calibrate initially and each time 
there is a hardware change. 

 

Figure 31:  The Scale factors in the Lens Setup dialog. 

Laser Software Instruction 

1. Copy Template.ezm and rename it for your job, or start the 
MarkingMate.exe to create a new blank file and then add a text 
string into the work area for marking. 
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Figure 32:  Adding text to mark the devices. 

2. Enter preview mode (see image below) to confirm the real world 
marking position is set to Cup1 of shuttle. Move the red light to 
cup1 position using the arrow key if they do not match. 

 

Figure 33:  The Preview button. 

3. Save the file and exit the software. 

CH700 Configuration 

1. Make a backup of the winAH400.ini file. 
2. In the winAH400.ini file make the following changes: 

a) Set MarkerSystem=UPRHAND to enable the laser. 



Setup  ■  Setting Up the Laser Marking Module 

- 58 -  Data I/O  ■  096-0465-001C 

b) Set LaserRemoteConnection=LOCAL to choose a laser control 
method. 

 

Note: Load Marking Data can show ‘MarkingMate’ Software for marking 
content edits. 

 

Figure 34:  The Load Marking Data button in the CH700 Setup window 

opens the MarkingMate Software. 

Note: Cup1 position must be set correctly by MarkingMate. 

3. Click System > Gantry > Laser tab.  
a. Switch on Cup1 Vac then click Preview to confirm red light 

aims at cup1. If not please run Markingmate to move the red 
light to match cup1.  

b. Switch on Cup2 Vac and click Preview and set red light for 
cup2. Change Offset X / Offset Y to set distance between cup1 
and cup2 in X/Y directions. 

c. The Power Diff. field is the laser energy diference between cup1 
and cup2; for example, if power of cup1 is set to 20%, here set 
to 10% means power is 30% for cup2. 

d. After setting the proper positions, click Laser Mark to check 
real marking results. 
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Figure 35:  The Laser tab in the Gantry window. See instructions in  

step 3 above for descriptions of controls on the Laser tab.  
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 Chapter Three 3 —
 

Administrative Functions 
The two primary levels of operation of PSV5000 are • 
Operator functions, and • Administrator functions. 

Only Administrator functions are covered in this manual. 

Operator functions are covered in the separate PSV5000 Operators 
Manual, although Administrators should be familiar with all operator 
functions. 

 
Administrators generally follow the sequence on the next page to create 
a job:  
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Creating a Job—Administrator Functions at a Glance 

 

Figure 36:   Detailed Administrator Functions begin on the next 
page. Shaded boxes are activities that are performed once per 
package type. 
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Safety Message and Precautions 
For your safety and preventing loss of time and damage to equipment, 
this manual uses special symbols, paragraphs, and color to call your 
attention to hazardous situations and recommend safe practices to help 
avoid them. 

Refer to Using This Manual on page - 1 - (in the Preface) for symbols and 
fonts used for safety messages. 

Refer to Safety Systems on page 12 for safety regarding Emergency Stops, 
the safety doors, and ESD. 
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Administrator Functions 
Administrators are responsible for creating Tasks in TaskLink™ and Job 
Creator, and for other functions not generally performed by operators. 
Administrators would likely perform these functions:  

•  Editing the winAH400.ini File on page 64 

•  Creating a Task in TaskLink on page 64 

•  Creating Security Profiles on page 65 

•  (Optional) Do a First Article Test on page 66 

•  (Optional) Setting TaskLink to Operator Mode on page 68 

•  Enhanced Yield Programming on page 68 

•  Teaching the Workspace Locations on page 69 

•  Optimize Movetimes on page 70 

•  Monitoring Statistics on page 71 

•  Maximizing Programming Yields on page 77 

•  (Optional) Creating a Data File from a Master Device on page 80 

•  Creating a Laser Marking File (if marking) on page 81 

•  Automotive Performance Pak on page 89 

These functions are discussed in this section. 

Reference List of Operator Functions 

These functions for operators are discussed in the separate Operators 
Manual.  

NOTE: All users, administrators, and operators should know these 
procedures. 

Checking the System 
Installing Input/Output Media 
Installing Socket Adapters and Actuator Plates 
Installing the Correct Probe 
(Optional) Installing the Correct Shuttle Cups 
Turning PSV5000 System Power ON 
Selecting a Job (Starting CH700 via TaskLink or Job Runner) 
(Optional) Preselecting Programmers 
Setting Media and Options—the Setup window 
Starting Programming 
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—After Starting a Job... 

Stopping the System 
Light Tower Interpretation 
(Optional) Changing Programmer Status 
Turning PSV5000 System Power OFF 
(Optional) Operating the Tray Feeder 

Editing the winAH400.ini File 

The winAH400.ini file can be edited to add or remove options which 
determine their availability in the CH700 Setup window. It also sets 
non-programming features such as language and which events cause 
warnings to display. This is a text file that can be edited in text editors 
such as Notepad or UltraEdit. Do not use Microsoft Word or other word 
processors since they may add hidden special characters such as 
end-of-page characters. 

CAUTION: File corruption hazard! Before making any changes to your 
winAH400.ini file, save a backup copy. 

The winAH400.ini is on the Handler computer in the C:\CH700\ folder. 

Creating a Task in TaskLink or Job Creator 

TaskLink stores Tasks (settings for programming job) for FlashCORE 
programmers in a Task database file (*.TSK). A Task contains all the 
information necessary for programming and testing specific devices with 
a specific algorithm. 
Job Creator stores Jobs for LumenX programmers in directory 
C:\LumenX\Jobs. A Task contains all the information necessary for 
programming and testing specific devices with a specific algorithm. 

SETTINGS AND FILES SELECTED FOR TASK/JOBS 

Tasks and Jobs include: 

• Device settings - identifies a specific device (or family of devices to 
select from) 

• Data file name and apropos settings 

• System settings - Package file name 

 

More information 
about the 
winAH400.ini file is in 
the CH700 on-screen 
Help. 

 

Once a Task is 
selected and a Pass 
Limit is set, the Task 
is referred to as a job 
to run on the 
PSV5000 System. The 
same Task can be 
used for many 
FlashCORE jobs. 
 
Note that operators 
can change the Pass 
Limit in the CH700  
Setup > Job Info 
tab. 
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• Process settings - Continuity check, electronic ID check, blank 
check, erase, verify, program, and device marking/labelling 
information. 

• (Optional) Setting the Pass Limit (the quantity of devices to 
program for this job) after clicking Run. 

In addition to containing all device-specific settings, a Task/Job 
references these files: 

File Information 

Package File 
(*.txt) 

For instructions on creating a Package File, 
see Teaching the Workspace Locations on page 
69. 

Data File (*.hex 
or *.bin, for 
example) 

The data file contains your data to be 
programmed into the devices. 

Laser Marking 
File 
 

See (Optional) Creating a Laser Marking File on 
page 81. 

TASK/JOB CREATION IS DETAILED IN THE SOFTWARE ONLINE HELP 

For complete instructions on how to create a Task/Job: 

• in TaskLink see TaskLink’s online Help Topics. 

• In Job Creator see Job Creator’s online Help Topics. 

Both applications will automatically start the CH700 Application 
Software when Run is clicked. 

(OPTIONAL) PRESELECTING PROGRAMMERS 

When CH700 starts, programmers that are not used for a particular job 
can be turned off to improve efficiency; see the PSV5000 Operators 
Manual for more. Note that operators also have access to this feature. 

 

It is NOT necessary to restart programmers between jobs. 

Creating Security Profiles  

With the Security Dialog in CH700, administrators can create and 
manage user profiles to control security by allowing different rights to 
different profiles. 
To create a new profile: 

 

Definition: A Task 
becomes a ‘Job’ once 
a Task is set to Run 
and a Pass Limit is 
requested and set. A 
Task can be used for 
many FlashCORE 
Jobs. 
 
Job Creator for 
LumenX 
programmers uses 
only the term Jobs 
(does not refer to 
Tasks). 
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Use the physical 
keyboard instead of 
the on-screen 
keyboard when 
entering passwords. 

1. At the Main CH700 (start) window, clicking Start will open the 
Security Dialog in the background. It may be obscured by other 
dialogs. 

2. In the Security Dialog, use the drop-down arrow to select Supervisor. 

3. Enter the password. 

4. Click Edit Users. 

5. Type a name into the Name field. 

6. Type a password into the Password field. 

7. Check the box next to each stated right (privilege) for the new user. 
For example: if the new user is to create or edit Package Files for 
jobs, check Teach Package. 

8. Click Save (the diskette image). 

(Optional) Do a First Article Test 

Prior to programming hundreds of devices, a newly created TaskLink 
Task is tested. Follow your company’s First Article Test Plan. The two 
methods discussed below are 1) Prior to creating a Package file, and 2) 
after creating it. 

TEST PRIOR TO CREATING A PACKAGE FILE 

Outlined below is a suggested test process using Data I/O’s desktop 
programmer called FlashPAK III. This method allows testing without first 
having to create the Package File required for PSV5000. 

1. Create a new Job for FlashPAK— 

1a. In TaskLink, set the Programming System to FlashPAK 
(System > Select Programming System > FlashPAK). 

1b. Open Task Manager and create a new Task with the Add 
button. 

1c. Create the Task as usual in the Edit dialog. 

2. Test the new Job on FlashPAK— 

2a. Using the Load button, send your new Task to a PC Card, 
or, if the FlashPAK is on a network, select it. 

2b. Test the Task on the FlashPAK by programming a device 
and verifying the results. 

3. Duplicate the Job for your PSV5000 System— 

 

For help with FlashPAK 
see its Operator’s Guide.  
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3a. If the job passed the tests, in TaskLink Task Manager, 
select the Task and click Duplicate. Enter a name and click 
OK. 

3b. Edit the Task so that it can be used on your PSV5000 
System as follows:  

I Select the Task,  

II Click Edit,  

III On the Task tab, use the Programming System 
Type drop-down arrow to select PSV5000,  

IV On the Handler Files tab, select (or create) a 
Package File name,  

V Click OK. 

4. Run the duplicated Task on the PSV5000 System— 

Note: If you have the option selected to Automatically Switch Programming 
Systems, (System > Options > Automatically Switch ...) then you can skip 
the next step. 

4a. Close Task Manager and change the programming system 
to PSV5000 System (System > Select Programming 
System). Re-open the Task Manager. 

4b. Select the duplicated job and click Run. 

Note: The Package File must be taught if it is new. 

TEST AFTER CREATING A PACKAGE FILE 

After a Package File is created (described in the next few headings) or it 
already exists for this package type and job, then this first article test 
method is best when your job includes Laser Marking. 

1. Create the PSV5000 job— 

1a. In TaskLink, create a new job for PSV5000 Systems. 

1b. Click Run (or Load) in TaskLink to start the CH700. 

2. Run one device— 

2a. In CH700, click Start. 

2b. In the Setup window, select media options as usual. 

2c. At the PSV5000 workspace set up the input and output 
media as usual. 

2d. Click Run > Run One. 

 

Programmers that are 
not used for a particular 
job can be turned off in 
the CH700 Start window. 
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2e. After it finishes, verify that the job passed the tests. 

Note: If a programmer does not have a Socket Adapter, or an incorrect 
Socket Adapter is installed, the programmer will automatically be 
disabled. 

(Optional) Setting TaskLink to Operator Mode 

Options to add, remove, and edit Tasks are found in TaskLink’s Task 
Manager Dialog when in Administrator Mode (the default). You can set 
TaskLink to Operator Mode which limits actions to running and viewing 
tasks in the Operator Dialog but not editing or deleting Tasks, Kits, or 
Archived Jobs. 

To switch between Operator Mode and Administrator Mode, see 
TaskLink’s online Help. 

Enhanced Yield Programming 

1. Several selections on the Setup window > Options tab affect yield 
that are not set in TaskLink. Administrators may wish to advise 
operators regarding the setting of the Continuity Retries field and 
the Fail Retries field. 

2. [Automotive Performance Pak only] Optional: Determine if any of 
the five utilities available with the AP Pak are required for this job. 
They must be set in the CH700 Setup window > Options tab. 

3. Set security rights for each operator that you do—and do 
not—authorize to make AP Pak changes. Changes to User Rights 
are made in the Security Dialog. 

Note: Only installed options are available for selection on the Options tab. 
If different input media (tape or tray) is desired, the winAH400.ini file may 
need to be edited. See the online Help for instructions editing the 
WinAH400.int file or contact Data I/O support or an authorized technician. 

Dry Run (Ignore Programmers) 

(Optional) If you want to do a Dry Run or transfer devices from input 
media to output media with no programming, click Ignore Programmers 
so it is ON (green); the PNP head will not stop at the programmers. Laser 

 

For more information 
about Security see 
Creating Security 
Profiles on page 65. 

 

For more information 
on the AP Pak, see the 
CH700 on-screen 
Help. 
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marking can be used with Ignore Programmers turned ON. The default is 
Off. 

Note: Set security rights for each operator to use—or not use—the Ignore 
Programmers option. Changes to User Rights are made in the Security 
Dialog. 

Teaching the Workspace Locations 

The Package File is a text file containing calibration information that the 
PNP head uses to properly pick, rotate and place devices. 

After your new Package File is taught, it will contain information about 
the specific device package and Socket Adapter as well as the number of 
programmers, input and output media, and optional equipment such as 
laser marking, if applicable. 

A Package File must be created for each device that uses a different 
Socket Adapter. If a Package File already exists that can be reused (same 
device package, same Socket Adapter, and same input/output media) a 
new one is not necessary. 

PREREQUISITES 
• A Task and a Package File must exist. For more information, see 

topics above. 

• A primary device has been selected. 

 

Figure 37:  Run window shown with static Trays. 

TO TEACH LOCATIONS 

1. Run the job in TaskLink/Job Creator/Job Runner that uses your 
new (renamed) Package File. 

1a. Select a Task/Job and click Run. 

 

Package Files reside in 
the Handler Computer in 
Folder 
C:\CH700\Package.. 
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1b. When the CH700 Application opens, click Start. 

1c. At the Setup window, make setup selections. 

1d. Click System > Gantry. A password may be required—refer to 
Creating Security Profiles on page 65. 

2. To continue, see the CH700 on-screen Help (Teaching Locations > 
Printable list of the steps). It covers teaching workspace locations for 
all media options. 

Note: The PSV5000 System can have static trays or a Tray Feeder. 
Teaching tray locations is the same for both. 

ERRORS 

Please Refer to CH700 on-screen Help. In the Help table of contents click 
Browse Sequences->Create a Package File->Errors Creating the Package File. 

Optimize Movetimes 

After the equipment locations are taught, you can optimize the 
movement of the PNP head in the work envelope. This command (Get 
Movetimes) calculates programming times versus head travel time to 
decide the best PNP head path, especially effective when some 
programmers are not used. 

To get Movetimes: 

1. On the Gantry window, click Get Movetimes. 

 

Figure 38:  Click Get Movetimes to optimize head travel. 

 
2. Click Yes when prompted to save positions. 
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For turning ON 
Sort-On-Error-Code in 
the winAH400.ini file, 
see the CH700 on-screen 
Help. 

For setting up 
Sort-On-Error-Code see 
TaskLink Help for 
PSV5000. 

Monitoring Statistics  

Occasionally, the system administrator may require statistics for a group 
of devices for a given job. This is easily accomplished using any of three 
statistics tools described on the next pages: 

• TaskLink’s Session Data Logging feature 

• the CH700 Statistics window 

• (optional) Statistical Process Control Software (customer-supplied) 

• Sort-on-Error-Code separates devices that fail specific, customer 
specified processes. 

In addition, Data I/O offers additional utilities for enhancing yield and 
reducing errors. These include the Automotive Performance Pak (see page 
89) and several other software packages and hardware such as Factory 
Integration Software (FIS) and Serial Number Server (SNS). 

TASKLINK SESSION DATA LOGGING 

For complete instructions on enabling and using TaskLink’s Session 
Data Logging option, see TaskLink online Help. 

CH700 STATISTICS WINDOW 

The PSV5000 software called CH700 provides statistics that include: 
devices programmed successfully, continuity failures, and verify failures. 

To view programming statistics using the CH700 software: 

1. At either the Setup window or at the Run window, click Statistics. 

2. Select either Package Type or Job Statistics from the drop-down 
field in the upper left corner. 



Administrative Functions  ■  Administrator Functions 

- 72 -  Data I/O  ■  096-0465-001C 

 

*For FlashCORE, only 
HIC Socket Adapters and 
HPS Socket Adapters are 
designed to 
accommodate 
replacement of 
individual sockets on the 
adapter board. 
For LumenX, Socket 
Adapters only have one 
socket. 

 

Figure 39:  At the Statistics window, the Job Statistic file can be 
viewed (Jobname.stx) as shown. When Job Statistics is selected, 
Pass/Fail criteria are logged for each individual socket and 
programmer listed in the left column. 

 

Figure 40:  At the Package Statistics window, statistic can be 
viewed by Package Type (PackageType.sts). 

RESETTING PACKAGE STATISTICS 

The Package statistics displayed correspond to the Package File and 
therefore to the Socket Adapter used. When a Socket Adapter is replaced 
on a programmer, statistics for that Socket Adapter must be reset. 

To reset Package statistics: 

1. In the Statistics window, select Package Statistics in the drop-down 
field in the upper left corner. Refer to the image below. 

1. Click Reset in the right-most column corresponding to the 
programmer on which the Socket Adapter was replaced.  
• For example, if a Socket Adapter was replaced, reset all rows for 
that programmer. 
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• If an individual socket was replaced*, reset only the row 
corresponding to the replaced socket. 

The R-date (reset date) is set to the current date and statistics are all 
reset to zero. 

 

Figure 41:  Resetting Package statistics. Open the Statistics 
window from either the Setup window or the Run window. 

STATISTICAL PROCESS CONTROL SOFTWARE 

The CH700 can be set to generate a semicolon-delimited file whose fields 
are described on the next page. A (customer-supplied) Statistical Control 
SW can be used to import and process data output by the CH700. Or use 
Data I/O’s Enhanced Statistical Software that comes with the CH700; 
refer to page 89. 

CAUTION: File corruption hazard! Before making any changes to your 
winAH400.ini file, save a backup copy. 

To generate a semicolon-delimited output file: 

1. On the Handler Computer, navigate to C:\CH700 and open 
winAH400.ini (with Microsoft® Notepad or IDM Computer 
Solutions’s UltraEdit®). 

2. Locate the section for SPC Logging. It will look like this: 

[SPC Logging] 
LoggingEnabled=FALSE 
MaxFileSize=10485760 
TempLogFile=C:\spcout.txt 

3. Set the second line (LoggingEnabled) to TRUE. 

4. (Optional) Edit the location of the output file at the line 
“TempLogFile=...” entering the drive and path desired. 

5. Save and close winAH400.ini. 
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Note: In the above example the SPC logging file is saved to C:\ directory. It 
can, however, be saved elsewhere on the Handler Computer hard drive, or 
on a networked drive if network connected. 

The SPCOut.txt file contains semicolon-delimited fields. A partial list 
follows: 

The SPCOut.txt Field Descriptions 

                                                              

01 DevicesInputsystem - number of devices picked from Input 

media 

02 DevicesInspected - number of devices inspected by Vision system 

03 InspectionQuality* - as percentage, compared with reference 

vision 

04 InspectionYield 

05 DevicesInsertedSocket - number of devices inserted into socket 

06 SocketYield 

07 ProgrammerYield 

08 ProgSysYield - Yield of all programmers together 

09 DevicesProcessedMarker 

10 MarkingYield 

11 SystemThroughputExcWait - starts with first device placed, 

excludes wait times. 

12 SystemTotalThroughputIncWait - starts when Run starts, 

includes wait times 

13 SystemYield 

14 AreaID - Programmer #1 = “17”, Programmer #2 = “18”, …, 
Programmer #6 = “40”) 

15 PosID - that is Socket # 

16 TimeStamp - Date/Time of SPC log entry 

17 OrderNumber - Job Name and or number 

18 Package - A Package File used for the job 

 

If the Automotive Performance Pak is installed, an extended SPC log file 
(with APP enabled) would have the following delimited fields: 

TimeStamp 
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JobName 

JobDescription 

Device 

Package 

VisionPRJ 

RecordID 

SystemStatus 

SystemMSG 

FromAreaID 

FromPosID 

DeviceStatus 

WhichCup 

SNused 

ToAreaID 

ToPosID 

DevicesInspected 

InspectionPassed 

InspectionQuality 

DevicesInserted-Socket 

SocketYield 

ProgrammerYield 

ProgSysYield 

DevicesProcessed-Marker 

DevicesMarked 

DevicesInputSystem 

SystemYield 

SystemThroughputExcWait 

SystemTotalThroughputIncWait 

DevicesOutputSystem 

MachineID 

ProgTime 

*Inspection quality contains a 4 number record divided by the pipe[|], 
such as 1|2|3|4. 

1:  100.0-> vision pass or XXX.X->vision error code 
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2:  dX 

3:  dY 

4:  dZ 

 

EXAMPLE: 
100.0|85.0|-152.4|-1022.4 

 

dX,dY are recorded in μm, dR is in microdegree (μdeg) 

Figure 42:  Sample SPC Log File line entry defined. 
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Maximizing Programming Yields 
Occasional declines in system yields may occur during day to day                                                                     
operation of the PSV5000 System. While overall yield levels can vary 
depending on device manufacture, any steep change in yields is 
sufficient reason for investigation of an immediate cause of variation. 

These changes in yield can be attributed to a number of causes, 
including device quality control, socket issues, system maintenance, 
and process errors. 

Quality Control of Devices 

Variations in the manufacture of devices may affect yields in an 
automated system, such as: 

 Variation in dimensions from different manufacturing lots or 
facilities can cause devices to fit improperly in the sockets or require 
reteaching the Package File to be placed successfully. 

 Presence of residual plastic on the edges of the devices (flashing) can 
cause devices to rest improperly in the sockets. 

 Die changes (shrinks, process improvement for improved wafer 
yield, etc.) require new algorithms. Data I/O tracks these changes 
with vendors and recommends all customers subscribe to the 
algorithm update program. 

 Die processes vary. Programming yields can sometimes vary on a 
normal die. Device families recently introduced to the market tend 
to have more fluctuations in yields until the semi-vendor's 
manufacturing process stabilizes. 

 Multiple fabrication sites often produce the same devices. 
Performance characteristics, including programming yield, can vary 
from location to location. 

 Lead oxide accumulating on device leads is an issue for some 
devices. This can vary with age and the storage conditions. 

 Programming yields decrease with the number of programming 
cycles. Devices that are processed more than once are more likely to 
experience problems. 

Socket Issues 

The programming sockets are perhaps the most important and 
vulnerable element of the PSV5000 System. They are subject to residue 
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Socket life is generally 
rated by the 
manufacturer as the 
number of insertions per 
socket after which yields 
may drop significantly.  

buildup, damage from mis-inserted devices (perhaps due to poor 
calibration of the placement system), and general wear and tear. 

Socket conditions that cause varying yields include the following: 

 Debris of any type can prevent sockets from closing completely. 
Debris may not be visible. Simple actuation may clear debris, or it 
may be necessary to clean sockets with low pressure, clean dry air. 
Blow out sockets every day. Refer to Inspecting the Socket Adapters 
on page 98. Actuate the socket to blow out debris from beneath the 
contacts. More frequent cleaning is recommended in a dirty 
environment. 

 Bent or distorted contact pins can cause intermittent socket 
failures. 

System Maintenance that Affects Yield 

PSV5000 machine maintenance is critical to maintaining high yields. 
Periodic cleaning, adjustment and replacement of worn elements ensure 
the best possible performance. These periodic procedures are outlined in 
Maintenance Schedule on page 4-2 and should be followed closely. 

Part of regular maintenance is ensuring that the system hardware is in 
good working order, and that settings are accurate. 

To check programmer hardware see FlashCORE Programmer Diagnostics 
on page 119. 

For accurate placement, ensure that workspace locations (also known as 
a Package File) are taught correctly. 

If throughput is down, perform Get Movetimes again: see Optimize 
Movetimes on page 70. 

Process Errors 

Finally, some process errors can result in reduced yield. While an 
automated approach eliminates most human error during production, 
errors in setup or maintenance can result in reduced yield: 

 Using old algorithms may affect programming yields. PSV5000 
System algorithms are updated weekly at 
http://www.dataio.com/algorithms/ and are available depending 
on your maintenance plan. Algorithms are updated via TaskLink or 
Job Creator. See the apropos online Help for more information. 

 Selecting the wrong device part number for the job in TaskLink/Job 
Creator, and therefore the wrong algorithm. 
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 Selecting unintended programming processes in TaskLink/Job 
Creator (sector protection, security options, verify options, 
continuity testing, blank checking). 

 Measuring yields too infrequently, so that a drop in yield rates is not 
detected until a large number of devices have failed. 

 Using the wrong data file (selected in TaskLink/Job Creator). 

 Socket abuse, such as digging failed devices out with sharp 
instruments. 

 Changing to a questionable vendor source. Lower quality devices 
tend to produce lower yields. 
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(Optional) Creating a Data File 
from a Master Device 

The PSV5000 System can read data from a master device and create a 
data file (also called a PC File) that can then be used in programming 
jobs. 

For complete instructions on creating a data file from a master device, see 
TaskLink (FlashCORE) or Job Creator (LumenX) online Help. 

 

Figure 43:  TaskLink’s online Help includes steps for creating a 
computer file from a master device. 

Marking Option 
A Laser Module is an option which marks the surface of the devices. It 
has a separate Operation Manual which came you're your PSV5000 
System if it has the option. 
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Figure 44:  Manuals for the laser device marker and Fume Extractor. 

 

Figure 45:  Laser marking uses a laser shuttle except when using 
Tape-Output. The shuttle is installed at the factory to transport 
devices to the laser beam.  

Installing the Laser Shuttle Module 

TOOLS REQUIRED 
Metric Hex Key set 

To install the Laser Shuttle Module: 

1. On the left side of the machine prepare the small clear safety covers 
for receiving the Laser Shuttle Module. 

Laser Shuttle 
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a. Loosen the screw on the lower left of a rectangular safety 
shield shown in Figure 47: (4 mm hex key). 

b. Unscrew the top screw (4 mm hex key). 

c. Rotate the rectangular shield counterclockwise 90°to the 
‘storage’ position and screw it to the fixed safety shield with 
the screw you just removed. Refer to the figure below. 

 

Figure 46:  To install the Laser Shuttle Module, rotate the shield 
counterclockwise 90°. 

2. Unscrew the five screws that secure large fixed safety shield (4 mm 
hex key). 

3. Install the Laser Shuttle Module onto the plate in the PSV5000 
workspace and screw it down with two screws (5 mm hex key) from 
the underside of the plate . See the figure below. 
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Figure 47:  Laser Shuttle fasteners are on the underside at 
approximately the two circled locations (near side only shown). 

4. Connect the air tube to the machine, two connectors are shown 
below. 

5. Connect the communications cable to the left side of the machine. 

 

Figure 48:  Left: the Laser Shuttle air connection (circled). Right: 
connected. 

Laser safety 
shield 

Laser Shuttle 

Laser Exhaust 
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Creating a Laser Marking File 

Laser graphics used to mark devices are generated using the 
MarkingMate software included with the Laser Option. It resides in the 
Laser Computer. Any style of marking (whether text-based, 
graphic-based, or both) can be generated and used for marking devices. 
The only limitation is the size of the device to be marked.  

NOTE: For instructions creating an image file for the Laser System, see: 
• the Laser_Configuration_And_Operation.pdf (customer letter 
983-5075-001A.pdf) on the Handler PC if your programmer was ordered 
with the laser option, or see the software operation disc for the 
MarkingMate software. 
• the CH700 on-screen Help topic Setting up and Teaching > Create a 
Laser Marking File. 

Verifying Proper Laser Operation 

WARNING: Possible health hazard from toxic fumes! Laser marking 
generates vapors, fumes, and particles that can be noxious, toxic. Follow 
maintenance procedures. Use proper ventilation. 

REQUIREMENTS 

• An image file is in the MarkingMate SW application.  

 

To verify that the laser is marking as expected: 

1. Put one device on the expected marking position. 

2. At the Laser window, click Laser Marker. This device will be marked. 
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Figure 49:  Laser Form in CH700 

3. Verify that the marking graphic placement on the device is as 
desired. If not, adjust the laser file in the UpperHand application or 
see the next heading on troubleshooting. 

ALIGNING LASER MARKING 

REQUIREMENTS 
• Two people 

• An image file is in the MarkingMate SW application. If the device is 
not marked, check that the laser is aimed at the device correctly. 

 
1. Stop any job that is running by clicking Finish on the Run window. 

2. Turn off the Laser Switch in the Laser power control panel. 

WARNING: Serious injury hazard to eyes and skin! Do not open 
or work on the Laser Module when the Laser Switch is in the ON 

position. Always make sure it is OFF.  
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Figure 50:  Laser Switch on the Laser power control panel. 

3. Open the MarkingMate software window (double-click the desktop 
icon). 

4. Click preview icon in the MarkingMate software. 

 

Figure 51:  The preview icon in the MarkingMate software 

5. Another operator open the PSV5000 front left safety door and 
unscrew the two screws on the inspection door of the Laser Module. 
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Figure 52:  Fasteners on the laser inspection door (arrows). 

6. Open the inspection door, which is hinged at the buttom, to view the 
laser position (red rectangle).  

 

Figure 53:  Inspection door in the open position. 

7. Use arrow key on the keyboard to move the laser position (red 
rectangle) to the desired position, lift the door open and recheck. 

Note: If the rectangle can’t move, make sure the laser pattern in the 
MarkingMate software is selected. 
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Figure 54:  If laser is activated, there will be a red spot at location of 
the arrow. 

8. Save the changes in the MarkingMate software. 

 

Figure 55:  Save icon in MarkingMate software. 

9. Install the inspection door to the previous position. 

10. Turn off the Laser Switch in the Laser power control panel. 

11. Retry marking device. Refer to the previous heading.  

 

If all appears correct and still there is no mark, contact Data I/O 
Customer Support. 

Note: The Laser rotor has been leveled at the factory. If you experience 
trouble, contact Data I/O Customer Support. 
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Additional Features 

Automotive Performance Pak 

Data I/O offers several utilities that are especially useful to certain 
industries. These utilities, labeled the Automotive Performance Pak (AP 
Pak), are described below. If your PSV5000 System does not have this 
feature, it can be ordered and installed.  

Contact Data I/O Sales. 

 

Figure 56:  The Automotive Performance Pak features appear in the 
Setup window. 

AUTOMOTIVE PERFORMANCE PAK SOFTWARE DESCRIPTIONS 

The Automotive Performance Pak (AP Pak) includes the following 
software and hardware components. 

ENHANCED STATISTICS 
The Enhanced SPC (Statistical Process Control) application is a 
standard feature on CH700 and allows precise tracking of machine 
behavior such as uptime, downtime, yields, and throughput. It produces 
job log files that are readable with Microsoft® Excel and Access software 
to graph the data.  (Excel and Access required.) 
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CONFIRM INPUT DEVICE (AP PAK OPTION) 
This safety enhancement checks that the input device is the correct one 
for the job each time the input media is changed. When a job starts or 
when the input media (such as Tape-In or Tray Feeder) is empty, a 
barcode must be scanned to continue. This barcode must match the 
value setup in the TaskLink task. Typically, it is the raw material part 
number of the devices. 

LABEL GENERATOR (AP PAK OPTION) 
This separate application is a utility for designing labels for reels of 
device tape or other media. Choose size, number of fields, and layout. 
Call up variables from TaskLink or enter new content. Print on-demand 
or automatically after each reel of devices. 

ORDERING AND INSTALLING 

Ordering the AP Pak involves sending Data I/O a number from the Setup 
window in CH700 with your purchase order. Data I/O will send a security 
file via return e-mail. Complete instructions along with the installation 
procedure are in the CH700 online Help: find Automotive Performance 
Pak in the online Help index. 
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A handy sign-off chart is 
at the end of this 
chapter. 

 

 

 

 

 Chapter Four 4 —
 

 

Maintenance 
Performing the maintenance procedures described in this chapter 
optimizes operation of your PSV5000 System, enhances longevity by 
minimizing wear and malfunctions, and reduces any downtime. 

The manuals that came with any optional equipment on your 
system may contain additional maintenance procedures. 

Note: Only individuals trained on these procedures by Data I/O or its 
representatives are qualified to perform maintenance on the PSV5000 
System. 

This section describes the preventive maintenance schedule for the 
PSV5000 System and equipment options, with topics appearing in this 
order: 

Maintenance Schedule starting on the next page 

Workspace, Head and Gantry on page 98 

Programmers on page 119 

The Laser Module on page 124 

Handler Computer on page 129 

Troubleshooting on page 131 

Tape Output System Maintenance on page 140 

Tray Feeder on page 148 
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Make copies of this chart 
and post near your work 
area. 

Maintenance Schedule 

This Maintenance Interval Chart below recommends intervals based on 
single-shift daily usage. Information about the specified procedures and 
intervals can be found on the pages referenced in the right column. 

An asterisk (*) denotes optional equipment. 

Date 

completed 

/ initials 

Component 
Action 

(see precautions also, on page listed) 
Page 

Items to check Every Day 

Every day Sockets Clean with dry compressed air. Check for wear; 
replace if necessary. For HIC Socket Adapters, see 
more information in customer letter Cleaning HIC 
Sockets (PN 983-5053) on our web site Technical 
Library. This link opens the PDF which lists 
cautions and suggested items, such as Cleaning 
brush (PN 5655500901) and ProGold Wipes 
(PN 5705500902). 

page 

98 

Every day Input air pressure Verify the input air pressure at the regulator is 
within specifications and that it is constant, that is 
the Nm3/min. [Normal Cubic Meter/min.] (SCFM ) 
must be stable. For specifications, see Connecting 
Air on page 34. 

page 
34 

http://www.dataio.com/DesktopModules/Bring2mind/SimpleDownloads/Download.aspx?tabid=149&mid=1341&file=bulletins-notices%5cCleaning_HIC_Sockets.pdf
http://www.dataio.com/DesktopModules/Bring2mind/SimpleDownloads/Download.aspx?tabid=149&mid=1341&file=bulletins-notices%5cCleaning_HIC_Sockets.pdf
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Items to check Every Week are below 

Every week 

 

 

 

 

 

 

 

 

 

Continued- 

Every week 

Programmers To help ensure there are no problems with the 
programmer hardware, run the programmers’ 
Self-test once a week at a minimum; more often is 
even better. The Power-On-Self-test (POST), which 
sets precision to a laser-trimmed reference, runs 
when programmers are powered up. This insures 
proper operation of the programmer’s voltage 
sources. 

 CAUTION: Possible damage to programmers 

and devices! DO NOT TURN AIR OR POWER OFF to 
the PSV5000 Machine while a job is running. 

A job must be Finished before turning OFF 
compressed air or electrical power. Wait for the 
gantry to park before turning OFF. 
 
Run the Self-test by either 
A) turning the PSV5000 System power OFF properly 
and then ON (Shutting Down the PSV5000 System 
on page 38),  or 
B) turning OFF only power to the programmers, and 
then ON, with the Programmer Power Switch on the 
Power Panel. If there is a programmer issue, a 
message will display when the next job is run. 

 

—Refer to the Operator’s Manual for switch 
locations. 

 

Every week General system Clean surfaces of equipment and all areas in 
workspace with a clean brush, cloth, or dry 
compressed air. 

Page 

102 

Every week Probe tips, on the 
PNP head 

• Inspect the Probe Tip to make certain it can 
create a good vacuum seal on the device. 
Replace if probe tip is worn, cut, or damaged. 

• Clean the PNP Probe tips with alcohol wipes 
(Data I/O PN 570-0410-001) or a damp cloth. 

Note: Do not touch the probe tip with bare 
hands. Finger oils can cause small devices to 
stick. 

Page 

103 
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Every week General system Laser Marking* page 

124 

Every week Tray Feeder* Check the Tray Feeder for damaged or broken parts. 
Check the conveyor belt and the guides for dirt, 
nicks, or other signs of damage. For more 
information, refer to the Tray Feeder Operator 
Manual. 

 

Items to check Every Month are below 

Every 
month 

Tray Feeder* Clean and Inspect the Tray Feeder.  

Every 
month 

Supply line air filter Check the main air filter and replace if necessary. 
Drain fluid. 

page 

107 

Every 

month 

Vacuum Generator 
filters at PNP head 

Check vacuum generator filters; replace as 
necessary. 

page 

108 

Items to check Every Three Months 

Every 
Quarter 

Camera Clean the Camera glass cover. page 

102 

Every 
Quarter 

LCD Display (Quarterly or as needed) 
Clean the monitor with consumer-grade ammonia 
glass cleaner. Spray window cleaner onto a soft, 
lint-free cloth and wipe the screen. DO NOT APPLY 
liquids directly to the screen. 
DO NOT USE alcohol or industrial chemical 
cleaners. 

 

Every 
Quarter 

Safety doors Clean with damp cloth.   

Every 
Quarter 

Probe stem O-Ring Replace the O-Ring on the probe stem.  page 

103 
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Every 
Quarter 

Gantry guide rails 
(every 100,000 
devices or every 
three months, 
whichever comes 
first) 

Clean and lubricate quarterly, or sooner if the 
gantry becomes noisy. 

Page 

110 

Items to check Every Six Months 

6-mos. PNP head Check; tighten if necessary. Page  

110 

Every 
6-mos. or 
as  
needed  
depending 
 on use 

Laser Marking 
System* 

Fume Extractor 

Clean the nozzle and extraction tube. 
 
 
Replace the Pre-Filter. 
 
 
Replace the main filter twice yearly, or whenever the 
Filter System alarm sounds and blinks the red 
lamp. 

Page 

126 

Items to check Once a Year 

Every year programmers Run conformance verification test using Data I/O’s 
DAB. Or have a Data I/O Service Technician 
perform the test. Customers with an APS contract 
have some costs of the test covered in the 
agreement. 
• FlashCORE Programmers: DAB part number 
910-2200-003 or higher. 
• LumenX Programmers: DAB Kit 910-2211-001A 
or higher.  

Page 

119 

Every year Vacuum Generator  
silencers PNP head 

Check vacuum generator silencers; replace as 
necessary. 

Page 

109 

* Denotes optional equipment 

Materials Required for Preventive Maintenance 

To perform preventive maintenance procedures on the PSV5000 System, 
in general you need the following materials. 
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Note: Specific items are noted at each individual procedure. 

GENERALLY REQUIRED ITEMS 

• Lens cleaning paper (Data I/O PN 570041) 

• Water dampened cloth for cleaning 

• Isopropyl alcohol 

• Antistatic cleaner 

• Dry, compressed air 

• Safety goggles 

• Disposable protective gloves 

• Particle (dust) mask 

• SAE and metric hex socket wrenches and hex keys (Allen 
Wrenches). Data I/O hex key set PNs: Metric 565-0006-001, and 
Standard 565-0007-001 

• Screw driver sets, flat and Phillips 

• Metric open end wrenches for the probe tips 

• Shop vacuum cleaner 

• Self-Serve Spares Kit (page 97) 

Turning off the Systems 

When the PSV5000 System will not be used for several days, or before 
performing a service procedure, turn OFF the system. 

See Shutting Down the PSV5000 System on page 38. 
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Self-Service Spares Kit 
The Self-Service Spares Kit, Data I/O part number 952-0508-001 or 
higher, can be purchased at any time. 

  

 

 

910-2200-00d or higher: Diagnostics 

Adapter Board (DAB) only for  FC 

programmer calibration  

(Sales PN: FC-DIAGNOSTICS BOARD)  

 

 

 

750-2474-001 or higher: an entire 
probe assembly 

480-0070-001 or higher: 16-port 

V-LAN Ethernet hub 

  

750-2464-001 or higher: programmer 

power supply  
2940220001 or higher: Pneumatic 

Silencer 
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Workspace, Head and Gantry 
The workspace includes the Socket Adapters and items on the working 
surface, but not the programmers. They are covered in a separate 
heading. 

Socket Adapters and Actuation 

Under this heading you will learn about visually inspecting, cleaning and 
adjusting sockets, actuation, and air pressure for the workspace items. 

INSPECTING THE SOCKET ADAPTERS 

The condition of the Socket Adapters has great throughput 
consequences. 

SOCKET LIFE 
The Run window displays the Socket 
Adapter lifetime actuation count in yellow 
until it is exceeded at which time it changes 
to red.  

 

SOCKET CLEANING 

WARNING: Vision hazard! Pressurized air or debris blown into 
the eyes or skin could cause bodily damage. Always use care and 

wear protective eye goggles when cleaning with pressurized air. 

1. Use clean, dry compressed air (at 6.2 Bars (90 PSI or less) to remove 
dirt from the sockets. Open and close the sockets while blowing them 
out. 

2. Check the sockets for wear and replace if necessary. 

Note: The socket replacement cycle depends upon the type of socket used 
and the socket manufacturer. 

TURNING OFF INPUT AIR 

Prior to turning off the input air, ensure that no job is running. 

CAUTION: Possible damage to programmers and devices! DO NOT 
TURN AIR OR POWER OFF to the PSV5000 Machine while a job is 
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running. A job must be finished before turning OFF compressed air or electrical 
power. Wait for the gantry to park before turning OFF. 

1. If a job is running, Pause or Finish it. 

2. On the Power Panel, rotate the valve clockwise to turn OFF the input 
air; it is off when the lock rings line up. See the figure below. 

 

Figure 57:  Input air regulator/filter on the Power Panel (on the left 
side of the machine). When the lock rings on the valve line up, 
the air supply to the PSV5000 Machine is OFF. 

3. (Optional) Paddle lock the air shutoff valve. 

ADJUSTING THE SOCKET ACTUATOR AIR PRESSURE ON THE PROGRAMMERS 

Socket Actuators are built into the FlashCORE programmers on 
PSV5000. Socket actuation is controlled by air pressure. If Socket 
Actuators are slamming up and down loudly, or devices are bouncing, the 
air pressure may be too high. If the PNP head does not properly pick or 
place a device in a socket because the socket is not opening completely, 
the air pressure might be set too low. 

Adjust the air pressure setting as follows: 

1. Finish a job if one is running. 

2. Navigate to the Gantry window and click the yellow label for a 
programmer that is easy to see. 

3. At the Actuator Tab, click Actuate Socket ON and OFF to visually 
verify performance for reference. 
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Figure 58:  The Socket Opener Pressure Control knob with built-in 
gauge on the Power Panel. 

4. At the Power Panel on the left side, adjust the air pressure up or 
down as desired by pulling the collar on the black knob out and then 
rotating it. 

5. Push the collar back in. 

Note: The lowest pressure setting that opens the sockets all the way 
reliably is recommended. 

6. Cycle the sockets as before to verify the change in action. 

7. Repeat if necessary. 

Note: If Socket Actuator problems persist, set the actuator speed (refer to 
the next heading). 

ADJUSTING THE SOCKET ACTUATOR SPEED ON THE PROGRAMMERS 

THE SOCKET ACTUATOR SPEED WAS SET AT THE FACTORY AND 
SHOULD NOT NEED ADJUSTMENT. If it is determined that adjustment 
is necessary, this procedure requires a Data I/O trained technician since 
it requires having an access door open while the machine power is on. 

REQUIREMENTS 
• Programmer air pressure must be correct. See previous heading. 

• Small flat screw driver. 

TO ADJUST THE SPEED OF THE SOCKET ACTUATORS: 
1. Ensure that power and air are connected and ON, and a Socket 

Adapter is installed on the target programmer. 

2. At the Gantry window, click the label for a programmer with the 
adapter installed. Probe 1 will stop over socket 1. 
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WARNING: Electric shock hazard! Opening any access doors while 
the power is ON can be dangerous even when steps instruct you to 
do so. Use extreme caution and do not touch any electronic 

equipment except as directed. 

3. Open the access door nearest the target programmer and locate the 
in-line air flow control for the up (sockets closed) position. Refer to 
Figure 4-3. 

 

Figure 59:  Actuator flow controls (arrow). The lower one (that the 
screwdriver is at) sets the UP speed. FlashCORE programmers 
shown here. 

4. Adjust the appropriate flow control 1/2 to 1 revolution clockwise 
for slower action, or counter-clockwise for faster action.  

5. Close the access door, and clear the door open warning on the 
monitor.  

6. At the Actuate tab of the Gantry window, click the Actuate Socket 
switch to ON while listening and watching the opener. If it is too 
fast it will produce a louder noise than optimum when it operates. 
If it is too slow it will look slow. 

7. Click Actuate Socket OFF. 

8. Adjust the flow controls as necessary and repeat the test. 

9. Perform the same procedure for the other flow control if necessary. 
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Cleaning the PSV5000 Machine 

GENERAL MACHINE CLEANING 

General cleaning should be performed on a weekly basis. General 
cleaning includes, but is not limited to, the following listed item. 

WARNING: Vision hazard! Pressurized air or debris blown into 
the eyes or skin could cause bodily damage. Always use care and 

wear protective eye goggles when cleaning with pressurized air. 

1. Remove all dropped devices, debris, and other materials from all 
working areas. 

2. With air and power OFF, remove all devices and materials that may 
have fallen inside the machine. 

3. Use dry, compressed air to remove all dust and debris from the 
work surface and from under the machine. 

4. Dust the safety doors, inside and outside, with an antistatic 
cleaner. 

5. Wipe the top and side panels to remove grease, fingerprints, and 
dust. 

6. Dust the top surfaces of the input/output modules. 

CLEANING THE CAMERA COVER 

Fingerprints and excessive amounts of dust or other residue on the 
camera cover will affect the alignment. 

If the camera can’t provide a good image, it may be an indicator that the 
cover needs cleaning. 

Wipe the camera glass in the work surface with a soft cloth and isopropyl 
alcohol. 
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Pick and Place Probe 
The workspace Pick and Place head (PNP head) has one probe which 
requires periodic maintenance. The headings below describe 
maintenance. 

Checking the Probe Tip 

A worn or damaged probe tip on the PNP head can cause dropped devices 
and placement problems. 

1. Check the probe tip for cracks or tears. If necessary, replace with a 
probe tip of the same size. 

2. Test the probe tip— 

2a. At the Setup window, click System > Gantry. 

2b. Click the Vacuum switch to ON. 

2c. Open the safety door and place a device on the target probe. 

2d. If the vacuum does not firmly hold the device, replace the 
probe tip with a probe tip of the same size. 

CHECKING THE PROBE 

Check that the probe is not loose. Tighten the set screw on the stem if 
necessary. If you suspect or hear an air leak: 

1. Remove the set screw on the probe 
stem. 

2. Pull off the probe stem and check 
the O-Ring. Replace if necessary. 

3. Reassemble. 

CLEANING THE PROBE TIP 

To clean the Probe tip: 

1. Move the PNP head to a convenient 
position by clicking one of the 
yellow labels on the Gantry 
window. The Tool position is 
recommended. 

2. Open the safety door. 

3. Wipe the tip with alcohol wipes 
(Data I/O PN 570-0410-001) or a 
damp cloth. 
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Note: Do not touch the probe tip with bare hands. Finger oils can cause 
small devices to stick. 

Adjusting Probe Blow-Off Pressure 

Note: The flow controls are set at the factory and should not require 
adjustment. If adjustments need to be made, they should be done in small 
steps until the desired results are reached. 

Blow-off is a small puff of air applied at the probe during the device drop 
event to assist in removing a device from the probe. Blow-off is produced 
by a vacuum generator on the PNP head. If set too high, blow-off could 
cause device misalignment during placement. 

TOOLS REQUIRED 

• Large flat screwdriver 

• Very small flat screwdriver 

To adjust blow-off pressure on any vacuum generator: 

1. Click System > Misc. I/O. 

2. At the I/O Interface window, select the desired vacuum generator, 
probe 1 or probe 2 (or both). 

3. Click Vacuum to the OFF position. Refer to Figure 4-4. 

4. Click Blow-off to the ON position. 

 

Figure 60:  Vacuum and Blow-off on the I/O Interface window. 

WARNING: Possible collision hazard! The high speed and force of 
the gantry can seriously harm anyone working inside the 



Pick and Place Probe  Adjusting the Vacuum Generator Sensor 
  

PSV5000 Owner’s Manual   - 105 - 

workspace.  
 
When working within the machine workspace, moving the PNP head must 
be the responsibility of only one qualified individual. All others must stay 
clear of the machine controls to prevent injury to that person.   
 
Ensure that a job is Paused or Finished, or the system power is OFF prior to 
opening any safety doors. 

5. Locate the actual vacuum generator (Data I/O PN 815-0047-001) on 
the right side of the PNP head. Find the blow-off adjustment 
set-screw. It is inside a long knurled stem which needs to be 
loosened before adjusting the set-screw. See the figure below. 

 

Figure 61:  The Blow-off adjustment set-screw on the vacuum 
generator is inside a knurled locking stem (arrow). (The vacuum 
block must NOT be removed as shown here.) 

6. Turn the adjustment screw until the vacuum generator readout 
displays +1.5 to 2.0 kPa. 

7. While holding the set screw with the screwdriver, tighten the knurled 
stem. 

8. Do the same for the other probe. 

9. Click Blow-off to the OFF position. 

If you had a blow-off problem, test your results. 

Adjusting the Vacuum Generator Sensor 

Note: If you notice consecutive programming pick errors, before adjusting 
vacuum sensors complete the Z-Axis adjustment. For instructions on Z-Axis 
adjustment, see Teaching the Workspace Locations on page 69. If 
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completing the Z-Axis adjustment does not reduce or eliminate subsequent 
pick errors, complete the vacuum sensor adjustments described here. 

Vacuum sensors on the PSV5000 System are adjustable. The I/O 
Interface window displays a list of the sensors in the PSV5000 System 
and the status of each sensor. 

Note: The number of sensors on the PSV5000 System depends on the 
options installed. 

To view the status of sensors at the main CH700 Setup window, click 
System > Misc. I/O. 

 

Figure 62:  The I/O Interface window reports sensor status and 
allows switching options on or off.  

TO ADJUST PROBE VACUUM GENERATOR SENSORS: 

1. Finish a job. 

2. At the Gantry window, move the PNP head to the Park position. 

3. Close the Gantry window and at the System window click Misc. I/O. 

4. At the I/O Interface tab, click the Vacuum toggle ON and the 
Blow-off toggle OFF. Refer to the figure above. 

5. Open the rear safety door. 

6. With a device or clean finger, plug probe tip 1 and ensure the green 
generator lamp comes on. See the figure below. 
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Figure 63:  The PNP Probe vacuum generator adjustments. (Looking 
in from the back of the machine) the vacuum generator faces up. 
The green lamp (arrow) is currently off. 

7. Read the high and low values each time you plug the air with your 
finger and release it. They are needed for the next step. 

8. Set the trigger value on the sensor by pressing the S (blue SET) 
button on the vacuum generator block and then using the UP or 

DOWN buttons, set the value to midway between the high value and 
the low value. It should be approximately -40 kPa. 

9. Press the SET button again. 

10. Check adjustment by blocking and unblocking the probe tip several 
times and ensuring the green lamp goes on and off each time. 

11. Repeat these steps for probe 2. 

12. Turn OFF the vacuum switch for the probe. 

Wipe the probe tip with a clean dry cloth. 

Replacing the Input Air Filter 

1. If a job is running, Pause or Finish the job. 

2. Turn off shop air and disconnect the input air line from the Air 
Filter/Regulator at the quick connect fitting. 

3. Unscrew the air contamination collection bowl housing. 

4. Pull off the clear collection bowl. Clean out any dirt, oil, or water. 

5. Unscrew the black knob below the filter. 

6. Pull off the filter. Clean or replace as necessary.  
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Reinstall in reverse order being careful not to damage the O-Ring on the 
bowl. 

Reconnect the shop air supply line. 

 

Figure 64:  Replacing the Air Filter/Regulator. 

Vacuum Generator Filters and Silencers 

These procedures cover removing and cleaning or replacing vacuum 
generator parts for vacuum generators on PSV5000 head. 

A clogged or dirty vacuum filter or silencer can cause dropped devices 
and placement problems at the PNP head. 

REQUIREMENTS 
• metric hex key set 

• flat screwdriver 

• small Phillips screwdriver 

VACUUM GENERATOR FILTERS 

1. Finish a job if one is running. 

2. Use the Gantry window to move the PNP head to an accessible 
location such as the Tool position. 

3. Properly shut OFF the PSV5000 System. See Shutting Down the 
PSV5000 System on page 38. 
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WARNING: Shock hazard! Opening the safety doors stops 
motion of the gantry only. It does not remove electrical power 
from the machine or any optional equipment. Turn the main 

power OFF for safety unless otherwise directed. 

4. Open the front safety door and mark the wire connectors at the two 
vacuum pressure switches on the right side of the head for returning 
them to the correct location. 

5. For access, unplug the two wire connectors (just marked) by pulling 
them out. See Figure 66: below. 

6. With a flat screwdriver, unscrew the knurled fastener on the 
underside of the nearest filter housing. See the figure below. 

7. Remove the filter housing and ensure that the O-Ring doesn’t fall. 

8. Remove the filter from the housing. It should be white or nearly 
white. If dirty or clogged, replace with new filter (Data I/O PN 
294-0219-001). See the figure below. 

 

Figure 65:  Removing the PNP head Vacuum Generator filter. The 
yellow arrow points to the wiring connectors. Two fasteners 
attach pneumatic generator block (circled). 

Reinstall in reverse order and plug the two wire connector back in at the 
same location. 

VACUUM GENERATOR SILENCERS 

There is a silencer in the vacuum generator block at the PNP head. To 
inspect or replace the silencer: 

1. Finish a job if one is running. 

2. Use the Gantry window to move the PNP head to an accessible 
location such as the Park position. 
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3. Properly shut OFF the PSV5000 System. See Shutting Down the 
PSV5000 System on page 38. 

WARNING: Shock hazard! Opening the safety doors stops 
motion of the gantry only. It does not remove electrical power 
from the machine or any optional equipment. Turn the main 

power OFF for safety unless otherwise directed. 

4. Open the safety door and remove the small silencer cover plate on 
the accessible vacuum generator (two 1.5 mm hex key). 

 

Figure 66:  The vacuum generator silencer. It is included in the 
Self-Service Spares Kit. 

5. Inspect the silencer. If it looks dirty—not white—replace it. 

6. Replace the cover plate. 

Inspecting Gantry Parts 

CHECKING THE PNP HEAD 

1. Properly shut OFF the PSV5000 sub-systems and machine power. 
Refer to Shutting Down the PSV5000 System on page 38. 

2. Check that all connectors are secure. 

3. Turn on the system air and check that there are no vacuum leaks. 

LUBRICATING THE GANTRY 

There are a total of seven grease ducts on the gantry for lubricating the 
linear guides. Additionally, the ball screw requires lubrication 
periodically, also.  



Pick and Place Probe  Inspecting Gantry Parts 
  

PSV5000 Owner’s Manual   - 111 - 

REQUIREMENTS  
• AFB‐LF from THK Grease 

• hex key set (Allen wrenches) 

WARNING: Possible collision hazard! The high speed and force of 
the gantry can seriously harm anyone working inside the 

workspace.  
 
When working within the machine workspace, moving the PNP head must 
be the responsibility of only one qualified individual. All others must stay 
clear of the machine controls to prevent injury to that person. Ensure that 
the system power is OFF prior to proceeding. 

 

WARNING: Possibility of serious eye damage! AFB LF grease 
causes serious eye irritation. Wear eye protection goggles. 

GANTRY X-AXIS LUBRICATION 
1. Move the PNP head to the Park position. 

2. Properly shut OFF the PSV5000 sub-systems and machine power. 
See Shutting Down the PSV5000 System on page 38. 

3. The guard on the back linear guide must slide out to the left or right. 
Therefore, remove either the left or right clear workspace side panel. 
Remove the four screws (4 mm hex key) and lift the panel off. 

4. Open the rear safety doors and remove the four screws in the gantry 
guard with a 2.5 mm hex key.  

5. At the open side of the machine, lift the end of the guard slightly and 
pull it out of the workspace. 

6. Remove the two screws covering the grease ducts. 

7. Apply grease to the two grease ducts on each end of the slide block 
(as shown on the next page). Wipe off any excess. 

8. Replace/insert the screws removed from Step 6. 
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Figure 67:  Two of the four grease ducts on the rear linear guide of 
the gantry. 

Note: Too much grease may cause grease to splatter inside the work 
envelope. Do not over-apply the grease. 

9. Lubricate the rear ball screw after wiping off the old grease. Directly 
apply new grease to the ball screw sparingly. Wipe off any excess. 

10. Open the front safety doors and remove the four screws securing the 
front guard of the front linear guide of the gantry (2 mm hex key). 

11. Remove the screw covering the grease duct. 

12. Apply grease to the grease duct on each end of the slide block. Wipe 
off any excess. See figure below. 
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Figure 68:  One of the two front gantry rail lube ducts. Note that the 
guard has already been removed. 

10. Lubricate the front ball screw after wiping off the old grease. Directly 
apply new grease to the ball screw sparingly. Wipe off any excess. 

11. Replace all screws, guards, and shields. 

 

GANTRY Y-AXIS LUBRICATION 
1. Open the front and rear safety doors and remove the four screws 

securing the guard of the Y-axis linear guide (2 mm hex key). 

2. Slide the guard out from either the front or back after pulling slightly 
to clear the end cap. 



Maintenance  ■  Pick and Place Probe 

- 114 -  Data I/O  ■  096-0465-001C 

 

A spare Probe Assembly 
comes with the 
Self-Service Spares Kit. 

 

Figure 69:  The Y-axis gantry ball screw and guide block, with cover 
(left) and without. 

3. Apply grease directly to the linear guide. Wipe off any excess.  

4. Lubricate the Y-axis ball screw after 
wiping off the old grease. Directly 
apply new grease to the ball screw 
sparingly. Wipe off any excess. 

5. Replace all guards and shields. 

 

Replacing a PNP Probe Assembly 

Technicians trained on the PSV5000 can remove and re-install a Probe 
Assembly if it is damaged or malfunctioning. 

Requirement 

• Metric hex key set (Long set with extended reach is best) 

• Spare Probe Assembly 

To remove a Probe Assembly 

1. End a job and move the PNP head to the PARK position (click System 
> Gantry > Tool) to move it to an accessible position. 

2. Properly shut down the PSV5000 System; refer to Shutting Down the 
PSV5000 System on page 38. 
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CAUTION: Possible Machine Damage! The PNP head and gantry 
can be damaged by pushing or pulling it improperly.  
 

• When moving the head, only push or pull by gripping a gantry part and 
not the head. 

3. Remove the probe from the Probe stem. Refer to Installing the Correct 
Probe in the PSV5000 Operator’s Manual. 

4. Disconnect the air hose form the vacuum generator (shown in the 
figure below) by pushing on the collar while pulling the tubing. 

 

Figure 70:  Remove the air line at the One-Touch air connector at 
the top of the assembly. Remove bracket fasters (arrows). 

5. Remove the bracket with the vacuum generator attached; four 
screws; three use 2.5 mm hex key, the back one uses 2 mm hex  
key. See Figure 71: . 

6. Unplug the ribbon cable from the back of the head assembly by 
pulling down on the connector. 



Maintenance  ■  Pick and Place Probe 

- 116 -  Data I/O  ■  096-0465-001C 

 

Figure 71:  Unplug the ribbon cable from the back. 

7. Disconnect the small connect at the top of the assemble by pinching 
the clip and pulling up.  

 

Figure 72:  Top connector on the P robe Assembly. 

8. Remove the four fasteners that hold the Probe Assembly to the PNP 
head. Refer to Figure 71: (A long 2.5 mm hex key is required.) 

9. Disconnect and remove the Z-axis retention spring (front side of 
assembly). 

10. Remove two wire connectors from the back of the motor. See Figure 
74: . 
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Figure 73:  Rear view of motor with two connectors (arrows). Note 
that the yellow wire is on the bottom of the small connector. 

11. Carefully pull the Probe Assembly with air tubing and wiring toward 
the front of the machine. 

 

Figure 74:  Probe Assembly is removed with the tubing and wires 
still through the head mount. 

REINSTALLING THE PROBE ASSEMBLY 

Generally, the reinstallation is in the reverse order of removal with these 
precautions: 

• Remember to thread the cables/tube through the head bracket. 
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• Ensure the ribbon cable doesn’t get pinched behind the probe 
assembly. 

• Make sure the Probe Assembly mates up to the locating pin on the head 
bracket.  

• It’s easiest to connect the two motor wires after putting the head onto 
the bracket but before screwing it in place. 

• Make sure tubes and wires are securely stowed and fixed to avoid being 
rubbed by any moving parts.  

• Remember to re-install the retention spring. 
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Programmers 
FlashCORE programmers require some maintenance to continually 
program at the highest yields.  

Note: For LumenX Programmer diagnostics refer to Customer Letter 
983-5085-001A. Check our website Technical Library. 

It is NOT necessary to restart programmers between jobs. 

FlashCORE Programmer Diagnostics 

To optimize programming yields, voltages within the FlashCORE 
programmer need to be calibrated once each year. This is a more 
thorough HW test than the 'POST' (Power-On-Self-Test) as well as 
ensuring that each programmer's precision reference is still within its 
specified operating range. 

Annual programmer Compliance Verification (CV) can be performed by 
Data I/O at customer sites. This on-site visit is included if you have an 
APS (Annual Programmer Support) contract (customer pays travel costs). 

Optionally, customer can purchase a Diagnostic Adaptor Board (DAB) 
and perform the compliance diagnostics themselves. Contact sales to 
purchase a DAB. 

 

Tools required 

• Diagnostic Adapter Board (DAB), Data I/O part number 910-2200-003 
(or higher). 

This Diagnostic Adapter Board detects problems related to FlashCORE 
(FC) programmer hardware failure. The DAB tests the Waveform Circuit 
Board and Backplane Circuit Board. The DAB can also be used to locate 
problems that have not yet shown symptoms. 

The DAB performs these nine tests: 

• Bus Test     • Vpp Overcurrent Test 

• Adapter ID Test   • I2C Bus Test 

• LED Driver Test   • DAC Calibration Test 

• G Node Test    • Gslew Test 

• Vcc Overcurrent Test 
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The wrist strap Data I/O 
PN is 440-0021-001. 

RUNNING THE PROGRAMMER DIAGNOSTIC TEST 

To run diagnostic tests on FlashCORE programmer(s): 

1. Finish a job if one is running; wait for the PNP head to park. 

2. Turn OFF the programmer circuit breaker at the Power Panel (down 
position).  

 

 

 

3. Exit CH700 to return to TaskLink. 

WARNING: ESD hazard! To prevent ESD shock, before you 
touch the Socket Adapter, discharge static electricity from 
yourself by touching a common ground or an unpainted metal 

surface.  
 
When at the PSV5000 Machine, always wear a wrist strap containing a 1 
M-ohm min. to 10 M-ohm max. current limiting resistor. Connect the 
antistatic wrist strap to the grounding socket on the front or back of the 
PSV5000 Machine. 

 

WARNING: Possible collision hazard! The high speed and force of the gantry 
can seriously harm anyone working inside the workspace.  
 
When working within the machine workspace, moving the PNP head must 
be the responsibility of only one qualified individual. All others must stay 
clear of the machine controls to prevent injury to that person.  
 
Ensure that a job is Paused or Finished, or the system power is OFF prior to 
opening any safety doors. 

4. Remove the Socket Adapter from the target programmer and insert the 
Diagnostic Adapter Board, ensuring that it aligns correctly on the adapter 
pins. Screw down the two bracket screws (4 mm hex key). 

5. Turn the programmer circuit breaker at the Power Panel ON (up 
position). 

6. Start TaskLink and click Tools > Run Programmer Diagnostics. 
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7. On the Diagnostics window, select the programmer with the DAB 
installed. 

8. Click Test All. 

The pass/fail test results are displayed in TaskLink and are also written 
to /fdrroot/system/diaglog.txt (and to the CF-card of the target 
FlashCORE programmer). These files can be viewed in TaskLink and 
saved (on the Handler Computer). 

If any of the tests show Fail in the TaskLink display, contact your nearest 
Data I/O Service Center for repair options. To help our service personnel 
diagnose the problem, please e-mail both the 

eventlog.txt and diaglog.txt files. 

 

Sample dialog.txt file: 

Diagnostic Pass #1 
Run Vpp Overcurrent test. 
DUT 1 G1 Vpp overcurrent is sensed at 57 mA. 
DUT 1 G2 Vpp overcurrent is sensed at 57 mA. 
DUT 1 G3 Vpp overcurrent is sensed at 57 mA. 
DUT 1 G4 Vpp overcurrent is sensed at 57 mA. 
DUT 2 G1 Vpp overcurrent is sensed at 57 mA. 
DUT 2 G2 Vpp overcurrent is sensed at 57 mA. 
DUT 2 G3 Vpp overcurrent is sensed at 57 mA. 
DUT 2 G4 Vpp overcurrent is sensed at 57 mA. 
Error: DUT 3 G1 Vpp overcurrent is not sensed from 50 mA to 70 
mA. 
Error: DUT 3 G2 Vpp overcurrent is not sensed from 50 mA to 70 
mA. 
Error: DUT 3 G3 Vpp overcurrent is not sensed from 50 mA to 70 
mA. 
Error: DUT 3 G4 Vpp overcurrent is not sensed from 50 mA to 70 
mA. 
DUT 4 G1 Vpp overcurrent is sensed at 57 mA. 
DUT 4 G2 Vpp overcurrent is sensed at 57 mA. 
DUT 4 G3 Vpp overcurrent is sensed at 57 mA. 
DUT 4 G4 Vpp overcurrent is sensed at 57 mA. 
Diagnostics failed. 
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Replacing a Programmer 

If a programmer is not working properly, it can be removed and replaced 
with another one. Within these instructions are notices where steps differ 

for LumenX programmers—denoted by the logo.  

TOOLS REQUIRED 
• Cable Tie tool 

• Clippers to cut cable tie 

• 3 mm hex key (Allen wrench) 

• Access door key that came with your PSV5000 

WARNING: Electric shock hazard! Injury or death may result 
from contact to parts inside the machine. Shut off the PSV5000 
System by turning OFF the main power switch before working 

on or near the gantry, before opening any access doors or removing any 
cabinet panels. 

To remove a FlashCORE programmer: 

1. Properly turn OFF the PSV5000 sub-systems and machine power. 
See Shutting Down the PSV5000 System on page 38. 

2. With the supplied door key, open the lower, right front access door. 

3. Locate the target programmer and follow the heavy gray power cable 
to the connection panel on the right side of the machine. Refer to the 
figures below. 

4. Mark the cable (to re-install in the same place) and pull the 

connector straight out from the PCB.  LumenX programmers 

have two connectors per programmer—mark and disconnect both. 
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Figure 75:  The right side connection panel inside the right front 
access door. Power cables (black arrow), Pneumatic manifold 
(white arrow),  

 and the Ethernet connections (circled).  

 For LumenX, there is another separate Ethernet router, not 

shown in this view. 

5. Follow and mark the thin shiny black tubing to the air manifold on 
the right mounting plate. 

6. Disconnect the air tubing at the one-touch connector elbow (push in 
on the collar while pulling the tube out). 

Note: Manifold port plugs must be installed into all ports that will not be 
used. 

7. Follow and mark the Ethernet cable to the router :  

 on the right mounting plate (FlashCORE programmers). 

 mounted nearby (LumenX programmers). 

8. Disconnect the Ethernet cable by pinching the clip and pulling up. 
Refer to Figure 76: . 
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9. Remove four screws (3 mm hex key) from the bottom side of the 
programmer (two nearside, two farside). One screw might also hold a 
cable tie which must be cut first. Save the cable tie mount for reuse 
(as well as the screws). 

 

Figure 76:  Inside the machine looking up at the programmers. 
There are four attachment screws (circled) per programmer. 

 FlashCORE shown,  but LumenX is similar, with screws 

farther apart. 

10. Open the front or back safety door to access the workspace. 

11. Lift up on the target programmer being cautious of the cables that will 
come out with it. 

Replacement is in the reverse order of removal. 

The Laser Module and Shuttle 
[Laser Marking only] Laser Marker System is optional equipment on 
your PSV5000 Programming System. The Laser Module employs a laser 
shuttle (except when using Tape Output) and includes a fume extractor. 

The Laser Module 

The Laser shuttle transports devices to and from the lasing area. 

REQUIREMENTS 

• Disposable gloves and protective goggles 

• Sealable Plastic bags 
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• Antistatic cleaner 

• Cloth Paper towels 

HOUSING 

 WARNING: Possible health hazard!  Lased materials can 

contain hazardous toxins in the dust that cause eye and skin damage! DO 
NOT use compressed air to remove laser dust or any method that allows the 
particulate to be released into the work environment. Wear safety goggles 
and disposable protective gloves.  

1. Properly shut off the PSV5000 sub-systems and machine power. See 
Shutting Down the PSV5000 System on page 38. 

2. Wear eye protection and put on disposable protective gloves. 

3. Use a damp cloth or paper towel and antistatic cleaner to wipe laser 
marking dust and other foreign material from the housing.  

4. Place paper towels, cloth, and protective gloves into a sealable plastic 
bag. Seal the bag and dispose of as hazardous waste. Remove safety 
goggles.  

 WARNING: Possible health hazard from toxic materials! Government 
regulations apply to the storage of hazardous waste. Ensure that 
contaminated filters are:  
• properly labeled and stored in your hazardous waste storage area 
• not stored on your site longer than government regulations allow (the 
typical limit is 90 days)—check your government regulations for hazardous 
waste storage requirements. 

CLEANING THE LASER SHUTTLE TIP 

Dirty tips may cause air leakage. Cleaning intervals depend on amount of 
use. 
To clean the tips: 

1. If machine power in ON, move the head: either 
  At the Run window: click Pause or Finish. 
  Or at the Gantry window: click Park or Tool. 

2. Open the safety doors. 
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3. Wipe the shuttle tips with a damp cloth—soapy water is okay. (Do 
NOT use alcohols or solvents.) 

Laser Marking Fume Extractor 

[Laser Marking only] All models with Laser Marking have a fume 
extractor. The fume extractor requires some attention as described 
below.  

START-UP 

 CAUTION: Possible health hazard! Dust from the main filter may be 
expelled on start-up after PSV5000 transportation. Turn the system ON in a room 
with appropriate ventilation or wear dust respirator and goggles. 

The Fume Extractor starts automatically when the PSV500 Machine is 
started (unless the extractor has been manually turned off). 

 WARNING: Possible health hazard!  Lased materials can 
contain hazardous toxins in the dust that cause eye and skin damage! DO 
NOT use compressed air to remove laser dust or any method that allows the 
particulate to be released into the work environment. Wear safety goggles 
and disposable protective gloves. 

CLEANING THE LASER MODULE AND FUME EXTRACTOR TUBE 

The filter extraction tube should be cleaned occasionally for best flow. 

Contact Data I/O Customer Support or a local Data I/O approved service 
representative. 

 WARNING: Health hazard! Failure to replace the laser vacuum filters 
at the required intervals could create a hazardous operating environment. 

 WARNING: Hazardous Materials—Possible health hazard! 
This procedure involves exposure to hazardous by-products from the laser 
marking process. Some device material may be carcinogenic. 
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Perform the following procedure only if you have training  regarding laser 
etching processes or handling hazardous materials. 
 
Wear safety goggles and disposable protective gloves.. 

For both these procedures contact Data I/O Customer Support or a local 
Data I/O approved service representative. 

REPLACING THE FUME EXTRACTOR FILTERS  

TOOLS REQUIRED 
• sealable plastic bag (approximately  .06 M3 [2 cu. ft.]) 

• protective gloves and goggles 

• a particle (dust) mask 

• access door key that came with your PSV5000 

• UpperHand Fume Extractor Operation Manual 

 

To replace the Fume Extractor Filters: 

1. Properly shut off the PSV5000 sub-systems and machine power. See 
Shutting Down the PSV5000 System on page 38. 

 WARNING: Possible health hazard!  Lased materials can 

contain hazardous toxins in the dust that cause eye and skin damage! DO 
NOT use compressed air to remove laser dust or any method that allows the 
particulate to be released into the work environment.  
Some device material may be carcinogenic. 
Wear safety goggles and disposable protective gloves.  

 

WARNING: Health hazard! Failure to replace the laser vacuum filters 
at the required intervals could create a hazardous operating environment. 

2. Wear eye protection and put on disposable protective gloves. 

3. Open the front access door. 
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Figure 77:  The Fume Extractor inside the front of the PSV5000.  

4. To continue, see the replacement instructions and part numbers of 
the UpperHand pre-filter and main filter in the UpperHand Fume 
Extractor Operation Manual (that came with PSV5000). 

 

 

Figure 78:  These four steps show filter replacement. Refer to the 
Fume Extractor Operation Manual. 

To finish, place the filters and your gloves in the bag and seal the bag and 
dispose of as hazardous waste. Close the access door. 
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Handler Computer 
The main PSV5000 Machine computer, or Handler Computer, is at the 
left side of the machine and requires little maintenance. 

Handler Computer Air Filter 

The Handler Computer has an air filter that requires periodic cleaning or 
replacing.  

To remove the air filter: 

1. Properly shut off the PSV5000 sub-systems and machine power. See 
Shutting Down the PSV5000 System on page 38. 

2. Open the filter door by unscrewing the two knurled knobs. The 
Handler Computer filter door has two knurled knobs (white arrows). 
The filter (screen) slides out. 

 

Figure 79:  The Handler Computer filter door has two knurled knobs 
(white arrows). The filter (screen) slides out. 

3. Open the filter door or lift it out. 

4. Pull out the filter tray out of the door. 

5. Clean filter as necessary such as with a light-duty vacuum. 
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Installing CH700 Software Updates 

CH700 Software updates are periodically published with improvements. 
Delivery depends on contract options.  

To install new CH700 Updates on the Handler Computer, insert the 
CH700 CD and follow instructions in the Instructions.rtf file. 

NOTE: Your existing winAH400.ini will not be replaced so all your settings 
will remain the same.  

NOTE: Updating TaskLink (FC) and Job Runner or Job Creator (LX) require 
different CDs than the CH700 updates. For more information, see the 
online Help for TaskLink or Job Runner or Job Creator. 

NOTE: PSV5000 System algorithms are updated periodically and are 
available depending on your maintenance plan. For more information 
about update kits or the support agreement plan go to  
http://www.dataio.com/Support/Software-Firmware  
 
Algorithms are updated via TaskLink (FC) and Job Creator (LX). For more 
information see TaskLink Help or Job Creator Help. To search for specific 
device support visit our Device Search web page: 
www.dataio.com/Support/Device-Support/Device-Search 
 

 

An APS is our 
Annual 
Programmer 
Support 
Agreement. 

http://www.dataio.com/Support/Software-Firmware
http://www.dataio.com/Support/Device-Support/Device-Search
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Troubleshooting 
This section contains solutions to problems that may arise during 
operation of the PSV5000.  

Troubleshooting for the Tape Output System is covered in a separate 
heading; see Tape Output System Maintenance on page 140. 

Also, see PSV5000 on-screen Help for a more detailed Troubleshooting 
chart.  

 

HEADINGS BELOW COVER THESE TOPICS: 
Common Error Messages 

Collect all PSV5000 System Logs on page 133 

Programming Problems on page 133 

Pick and Place Problems on page 137 

Air Pressure Problems on page 138 

Tray Feeder Problems on page 139 

Handler Computer Failure on page 139 

Common Error Messages 

Lamp Color Error Messages Possible Resolution 

Red •  Cannot connect to the 

motion controller. 

•  Check that both Emergency Stop buttons are 

OFF.  

•  Check that all safety doors are closed. 

•  Properly shut down the PSV5000 Machine if 

possible, and restart the system. 

Red •  E-STOP  

ACTIVATED but the 

OK button is grayed 

out (unavailable) 

•  heck that both E-Stop buttons are 
released. 

• Check that all safety doors are closed. 

•  If a restart is necessary, press Ctrl + Alt + Del 

on the keyboard 
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Yellow •  Tray not present PSV5000 does not detect the tray and when 

you click Run, you get error message Tray Not 

Present; or the Run window shows a tray 

where there is none. 

 

•  Re-install the tray.  

•  At the Run window, the Tray Present Sensor 

should be ON. 

•  If the tray is still not detected, remove the 

tray and place a finger over tray present 

sensor.  

–If sensor is working, tray outline appears. 

Re-install tray. 

–If sensor is not working, the tray outline 

does not appear—contact Data I/O 

Customer Support or a local Data I/O 

approved service representative 

Red •  Z MOTION ERROR 

800: LIMIT 

EXCEEDED ON AXIS 2 

Conditions: A Red ERROR box appears in 

bottom right corner of the Monitor. 

 

Contact Data I/O Customer Support or a local 

Data I/O approved service representative. 

Red/Yellow •  Error Tape Out •  If a device is jammed in the Tape Output 

System, clear it. Acknowledge the error 

message by pressing the ESC key. Then click 

OK on the PSV5000 Monitor. 

•  If above doesn't work, call the Service 

Technician. 

Red •  Main Air OFF •  Check that the main input air valve is in the 

ON position. 

•  Check that the main air hose is connected. 

•  Check that the air pressure is within the 

required range (green LED readout instead of 

red.) 

•  Contact Data I/O Customer Support or a 

local Data I/O approved service 

representative. 

Red •  Vacuum error •  See Adjusting the Vacuum Generator Sensor 

on page 105. 

•  Contact Data I/O Customer Support or a 

local Data I/O approved service 

representative. 
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RESTARTING AFTER TROUBLE 

If the CH700 Software closes, locks up, or experiences some trouble that 
qualifies as a crash, then the PSV5000 Machine power must be turned 
OFF for 20 seconds prior to restarting the software. 

Collect all PSV5000 System Logs 

Collect PS Logs is a software utility on CH700 Software that collects all 
log files from PSV5000. It creates a ZIP file containing all the information 
that Data I/O or trained service technicians need to evaluate your 
PSV5000 Machine status.  

PROGRAMMER RELATED PROBLEMS 

When you experience a programmer related problem: 

1. Force the error to re-appear by running a job, or performing the 
same steps that led to the trouble. 

2. (Note any dialogs with the Collect Logs button) and close CH700 the 
usual way as follows: 

a. Click Finish to stop a job. 

b. Exit the Run window. 

c. Exit the System window.  

d. Exit the Setup window. 

3. Start Collect PS Logs. See heading Starting ‘Collect PS Logs’ below. 

OTHER PROBLEMS 

For problems that are NOT programmer related, run the Collect PS Logs 
application any time after the problem has been seen. 

STARTING ‘COLLECT PS LOGS’  

There are three methods to start the Collect PS Logs application. 

AUTO METHOD (THE APP ISN’T VISIBLE) 
AUTO Method uses default settings— The Auto Method itself has two 
ways to collect logs. The Collect Logs Application does not open with 
these auto methods. 

• FIRST AUTO METHOD: The CH700 Software displays a button in 
each message box that allows you to start the Collect PS Logs 
application in AUTO Mode. 
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• SECOND AUTO METHOD: The CH700 Software also displays a 
button in the System window. 

 

 

When starting Collect PS Logs in AUTO Mode, only a progress screen is 
shown on the lower left corner of the screen. All defaults are used and no 
user action is required. A log zip file named with the current date and 
time is saved in the Documents folder (C:\Documents, or 
C:\Libraries\Documents.) 

START APP METHOD IN WINDOWS OS 
The Start App (non-auto) method is the Windows method using the 
Windows Start menu; it offers some options. Click Window Start > All 
Programs > Data IO > Collect PS Logs. 

 

After starting Collect PS Logs from the Start menu, the main window 
appears where you can select which items you need to collected.  

1. Select or clear check boxes for files as desired. 
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2. (Optional) Check additional SPC files if the error rarely appears or 
appeared a long time ago. 

3. (Optional)  In Collect PSV5000 Logs, to enter a text description to 
the Zip file: 

a. Click Add description. 

b. Type a description into the field available. In addition to what 
you type, the description will include the Date and Time the 
log was captured and the serial number information from the 
winAH400.ini file. 

4. Click Collect and ZIP. 

A ZIP file is created and copied to the Windows Clipboard. A message 
advises pasting it into a folder you choose. 

5. Click OK to the message about pasting the ZIP file to a desired folder. 

 

For more information see the CH700 on-screen Help. 
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Programming Problems 

Lamp Color Error Messages Possible Resolution 

None •  One programmer has 

many continuity 

failures (in Statistics 

window). 

•  Move the Socket Adapter to another 

programmer to see if the problem is the 

programmer or the adapter, as follows: 

1.  If a job is running click Pause and wait 

until all programmer activity is done. 

2. Check that there are no devices in the 

target adapter. If there are, click Finish. 

3. Replace the target Socket Adapter with 

another empty adapter.  

 

If the failure moves with the Socket 

Adapter, check for bent, damaged or worn 

pins on the sockets.  

 

If continuity failures persists in the same 

programmer, see Pick and Place Problems 

on page 137. 

If a programmer is not performing and you 

cannot correct the error, you can continue to use 

other programmer sites after disabling the 

non-functional programmer. See Disabling 

Programmers in the PSV5000 Operators 

Manual or the CH700 on-screen Help. 

Red •  All programmers fail to 

program devices. 

•  Check that the Programmer Simulation 

switch on the Setup window is OFF. If not, 

switch it to OFF. 

•  Check that the Programmers circuit switch 

on the Power Panel is On. 

•  Check the Log file for helpful information as 

follows: 

1.  Pause the job. 

2.  Exit the Run window. 

3.  At the Setup window click System > 

Log File. 
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Pick and Place Problems 

Lamp Color Error Messages Possible Resolution 

•  Red/ 

Yellow 

•  Devices are not being 

placed into sockets or 

output media 

accurately. 

•  Check that the probe is not bent. 

•  Check all fasteners and connections on the 

head and gantry. Also see Inspecting Gantry 

Parts on page 110. 

•  Yellow/ 

Red 

•  The probe experiences 

pick and/or place 

errors regularly.  

•  Contact Data I/O Customer Support or a 

local Data I/O approved service 

representative. 

•  None •  The probe is dropping 

devices. 

•  Clean or replace the Probe Tip. See Pick and 

Place Probe on page 103 

•  Clean the vacuum filters. See Vacuum 

Generator Filters on page 108. 

•  Check the main input air pressure; refer to 

Connecting Air on page 34. 

•  None •  A probe attempts to 

pick a device twice 

even though it picked 

up the device the first 

time. 

•  The Vacuum sensor may need calibrating. 

See To Adjust Probe Vacuum Generator 

Sensors on page 106. 

•  If programming TQFP 144, you can increase 

the value for ‘suckup time’ in the Package 

File to maximum value of 500 ms. See the 

Setup window > System > Package File. Refer 

to the on-screen Help. 

•  None •  Devices are bouncing.  The socket air pressure may be too high.  

•  Reduce the socket actuation air pressure. 

See Adjusting the Socket Actuator Air 

Pressure on the Programmers on page 99. 

Red/ 

Yellow 

•  Pick or place errors at 

all programmers. 

The socket is not opening completely—the air 

pressure might be set too low. 

•  Adjusting the Vacuum Generator Sensors on 

page 105. 

•  Increase the socket actuation air pressure. 

See Adjusting the Socket Actuator Air 

Pressure on the Programmers on page 99. 
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Air Pressure Problems 

Lamp Color Error Messages Possible Resolution 

Red •  There is no main air 

pressure. 

•  Make sure that the main air switch on the 

Power Panel is in the ON position. 

•  Check that the air regulator on the Power 

Panel displays within the acceptable range: 

PSV5000 Specifications on page 1-9.  

 

If not:  

• Check your shop air pressure. 

• Shut down and replace the filter. See 

Replacing the Input Air Pressure on page 107. 

 

The digital display on the regulator will be 

green when air pressure is within the correct 

range and red when it is out of range. The 

regulator has been set at the factory and is 

not adjustable. 

Red •  There is no (or low) 

vacuum on the PNP 

probe. 

•  Check that the probe is not loose and that 

the O-Ring is not destroyed or leaking.  

 See Pick and Place Probe on page 103. 

•  Determine if the PNP head probe is clogged. 

Clean if necessary. Refer to Removing and 

Installing a Probe in the PSV5000 Operator’s 

Manual. 

•  Check the probe vacuum and Blow-off 

solenoids; see Adjusting the Vacuum 

Generator Sensors on page 105. 

•  Clean the vacuum generator filters and 

silencers; see Vacuum Generator Filters and 

Silencers on page 108. 
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Tray Feeder Problems 

Lamp Color Error Messages Possible Resolution 

Yellow •  The Run window 

indicates a tray is 

present on the Tray 

Feeder when there is 

no tray there, or vice 

versa.  

•  Navigate to the System > MISC I/O window 

and verify that the Tray Present Sensor = ON. 

None •  Probe miss-picks or 

misplaces devices at 

the trays.  

•  Probe hits devices in a 

tray hard at one end 

and not the other. 

•  Check that the tray feeder is level. Adjust the 

outside mounting bar if necessary. 

 

Handler Computer Failure 

If the Handler computer drive fails, its behavior or a message indicates 
that a computer has crashed.  

Your PSV5000 System is equipped with a mirror-backup system called 
RAID that creates a real-time ghost image. You will see an error message 
display for a few seconds at system start-up. 
 

Figure 80:  This message, DEGRADED, will display for about seven 
seconds at startup if a Handler drive has failed.  
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Your PSV5000 System will continue to operate as normal on the 
backup drive. However, the failed drive must be replaced for 
continued safety.   

After the failed drive is identified and replaced, the message on-screen 
will read REBUILDING. After it has rebuilt, the next time you start up it 
will read NORMAL. 

Contact Data I/O Support or your nearest Data I/O representative. 

 

Figure 81:  The RAID solid state hard drives are inside the Handler 
PC case. The Handler PC must be removed to access the RAID 
backup drives. In image B, the Handler PC cover has been 
removed: this image is a representation only for reference. 

Tape Output System Maintenance 
The Tape Output System is an optional system for placing and taping 
programmed devices into device tape.  

Items not covered here can be found in the TM-50 Taping Module User’s 
Guide that came with your PSV5000 System. 

Cleaning the Pressure Seal 

The Pressure Seal Tape Output System requires cleaning to prevent 
problems with breaking the device tape or tearing the tape sprocket 
holes. Cleaning removes build up from the cover tape application rollers 
and the drive sprocket top pressure idler wheel. 

CLEANING TOOLS REQUIRED 

• Dry or damp shop towel  

• A reel of empty device tape (carrier tape) 

• A reel of cover tape 

 

B 
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To clean the Pressure Seal Tape Output System: 

1. Turn ON the PSV5000 System power and air.  

2. Start TaskLink.  

3. Select a job that requires the use of the tape output. 

4. Click Run (and Yes or OK to subsequent dialogs), which opens 
CH700 automatically. 

5. Click Start. 

6. Turn on the Tape Output Controller by pushing the red Power 
button. Refer to the figure below. 

7. At the V-TEK start-up screen, select Setup by pressing the left arrow 
button. 

 

Figure 82:  Tape Output Module Controller. The arrow points to the 
Power On/Off button which is also the Emergency-Stop (for the 
Tape-Out Module only!). 

8. Configure the Tape Output Controller by setting the following: 
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AT THE SETUP MENU: 

• reset Count Stop to desired amount: 
Press 1, to re-zero the present count 
Press 2, then enter the desired number, then press the 
ENT button. 

• select the desired device tape pitch from the Pitch 
Selection menu. Then press ENT. 

The pitch can be determined by using the pitch setting decal 
located on the loading track or the pitch setting guide found at the 
front of the TM-50 Taping Module User’s Guide. 

 AT THE ADVANCE MENU: 

• set the number of pockets to advance to 1. Then press 
ENT. 

 AT THE SPEED MENU: 

• set the advance speed between 40 to 100 depending on 
the device tape width and device size. Then press ENT. 

 

NOTE: Prevent device tape breakage and advancement problems 
with  narrower tape widths by setting slower speeds— in range 
40 to 60.  
Higher speeds may cause the devices to be dislodged from the 
pockets or may cause the sprocket holes on the tape to rip out. 

AT THE JOG MENU 

• jog the device tape forward to align the pocket with the 
PNP head. 

 AT THE MODE MENU 

• select PSA mode for pressure seal cover tape. An asterisk 
indicates the current setting. Then press ESC. 

NOTE: The Heat Seal switch should be OFF. 
 

 AT THE RUN MENU 

• select Run Mode.  The run window displays all the 
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selected setup parameters. 

• verify all settings for accuracy. 

 

9. Inspect the PSA seal rollers for build up of grime from the cover tape. 
See the figure below. 

 

Figure 83:  On the Tape Out Module, the PSA Seal Rollers (arrows) 
and Sprocket Idler with O-Rings. 

 CAUTION: Possible Machine Damage! Do not use solvents other than 
alcohol when cleaning the black polyurethane wheels. 

10. If grime buildup exists on the PSA Seal rollers— 

a. Using a shop towel and alcohol or alcohol wipes, clean the 
build up from the cover tape application rollers. Hold the 
alcohol cloth on the roller and rotate the roller 360°.  

b. Repeat procedure for the other application roller.  

11. Inspect the drive sprocket top idler and rubber O-Rings for any build 
up from the cover tape. See the figure above. 

12. If grime buildup exists on the idler and O-Rings— 

 CAUTION: O-Rings might be easily damaged. Handle gently to avoid 
breaking them. 

a. Gently remove the two O-Rings from the drive sprocket idler.  

b. Using a damp cloth or a commercial wipe, remove all grime 
from O-Rings.  

O-rings
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c. Wipe the idler clean. 

d. Reinstall the dry O-Rings onto the idler. 

Adjusting Pressure of the PSA Seal Rollers 

1. Advance the device tape with the cover tape through the Seal Rollers 
using the manual advance pedal. Advance enough pockets to 
correctly align the cover tape on the carrier tape.  

2. Perform a peel back test by peeling the cover tape from the carrier 
tape. Notice how well the cover tape adheres to the device tape. 
Perform a twist test by giving the tape a slight twist. Notice if the 
cover tape detaches from the device tape.  

If either test produces loose cover tape, increase the application 
roller pressure by screwing the PSA Seal pressure adjustment screw 
in (clockwise).  

If both tests look acceptable, visually inspect the sealed device tape 
for adhesive that may have been squeezed out during application. If 
adhesive is visible, the Seal Roller pressure is too high. Decrease the 
application roller pressure by screwing the PSA Seal pressure 
adjustment screw out and retest. 

Troubleshooting the Tape Output System 

The Tape Output System contains sensors that detect these fault 
conditions: 

• a device is on top the device tape (carrier tape)—Track Jam 
Sensor 

• no cover tape is on the reel—Cover Tape Sensor  

• device tape is not properly inserted in the device tape 
track—Device Tape Present Sensor 

• a pocket in the carrier tape is empty—Pocket Empty Sensor 

When the CH700 software displays the error message Tape Out Unit, 
one of the tape output system sensors has been triggered. The most 
likely sensors to trigger are the Device Jam and Device Tape sensors. See 
figure below. 
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Figure 84:  Optical Fiber Amplifiers: Cover Tape Present and Empty 
Pocket, respectively. Amplifier doors are open in the right side 
view. 

  

Front View 

Right Side View 
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The Track Jam sensor

Lamp Color Error Messages Possible Resolution 

None TRACK JAM SENSOR 
Tape Out Unit error message 

displays and a red LED 

lights in the Device Jam 

Sensor. 

•  Use a vacuum tool to seat the device in 

the device tape pocket. 

•  Re-seat the device tape in the Adjustable 

Loading Track.   

•  Use air to blow any debris out of the 

Device Jam sensor path. 

•  Adjust the Device Jam Sensor Controller. 

See Track Jam Sensor and Controller 

 on page 146. 

None COVER TAPE SENSOR 

AND AMPLIFIER 
Error message on the Tape 

Out Unit displays and a red 

LED is illuminated in the 

Cover Tape Sensor amplifier 

(left amplifier). 

•  Replace the empty cover tape reel with a 

full one. 

•  If the reel still contains cover tape, adjust 

the Cover Tape Sensor Controller. See 

Track Jam Sensor and Controller 

•   on page 146. 

None 
 POCKET EMPTY SENSOR 

AND AMPLIFIER 
A Tape Out Unit error 

message displays and a red 

LED is illuminated on the 

Pocket Empty Sensor 

amplifier. 

•  Adjust the pocket-Empty Sensor. See 

“Adjust the Pocket-Empty Sensor as 

follows:” on the next page 

 

 

TRACK JAM SENSOR AND CONTROLLER 

The Track Jam sensor detects when a 
device is not properly seated in the pocket. 
This sensor is located on the Adjustable 
Loading Track immediately before the 
carrier tape enters the cover taping area.  

COVER TAPE SENSOR AND AMPLIFIER 

The Cover Tape sensor detects when there 
is no cover tape on the reel. When the Cover Tape sensor is triggered, a 
red LED is illuminated in the Cover Tape Sensor Controller.  

 

 



Tape Output System Maintenance  Troubleshooting the Tape Output System 
  

PSV5000 Owner’s Manual   - 147 - 

ADJUSTING THE COVER TAPE SENSOR CONTROLLER 

1. Ensure that the Output Selector 
mode is set to D.ON by pressing 
the Mode button. (There may be 
an L/D ON button or toggle to 
change the mode.) 

2. Install a roll of cover tape onto 
the spindle.  

3. Press and release the SET button 
in the left amplifier. 

4. Remove the cover tape. 

5. Press and release the SET button again. 

NOTE: If an error occurs or the sensor fails to detect the cover tape after 
switching from a different type of cover tape, then the Cover Tape sensor 
may need to be re-taught to sense that particular type of cover tape.  

POCKET EMPTY SENSOR AND AMPLIFIER 

The Pocket Empty sensor alerts the operator when a pocket is empty as 
the device tape approaches the cover taping location.  

ADJUST THE POCKET-EMPTY SENSOR AS FOLLOWS: 

1. Set the track width for the target device tape 

A) loosen the two Track Width Lock knobs,  

B) pull or push the side nearest the operator to correct 
width,  

C) tighten lock knobs. 

2. Load a roll of device tape onto the spindle and into the track.  

3. Loosen the knob on the left side of the Pocket Empty Sensor 
bracket to adjust the height above the tape. Retighten. 

4. Loosen the knob on top to center the sensor on the tape. 
Retighten. 

5. Advance the tape until a pocket with a device in it is centered 
under the sensor. 

6. Ensure that the Output Selector mode on the middle amplifier is 
set to D.ON by pressing the Mode button. (There may be an L/D 
ON button or toggle to change the mode.) 

7. Press and release the SET button in the right amplifier. 

8. Remove the device from the tape pocket. 
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9. Press and release the SET button again. 

NOTE: The Pocket-Empty Sensor must be reset for each new device type 
to be taped. 

The Tray Feeder 
The Automatic Tray Feeder is optional equipment to the 
PSV5000 System. It is a high-speed tray exchanger, delivering JEDEC 
trays to pick and place positions. 

Information not found here, but important, can be found in the Tray 
Feeder Operation Manual, such as the location of possible pinch points. 

Cleaning and Inspecting the Tray Feeder 

[Tray Feeder only] 

1. Stop or Pause a job if one is running. 

2. Check the automatic Tray Feeder for damaged or broken parts and 
replace as necessary. 

3. Visually inspect the shuttle belts for dirt, nicks, or other signs of 
damage.  

4. If the shuttle belts are dirty, clean with dry, compressed air and wipe 
with a dry, lint-free cloth and isopropyl alcohol. 

5. Check that the shuttle/elevator is clean and that trays lay flat. 

Electrical Equipment Disposal 
Notice 

 For customers in the European Union, this symbol displayed 
on your Data I/O product indicates that the item must NOT 
be discarded with general municipal waste. Either return 
products displaying this symbol to Data I/O so that they may 

be recycled or reused, or otherwise properly disposed of according to the 
European Union's WEEE Directive. You may also dispose of it yourself in 
accordance with the European Union's WEEE Directive. 

Data I/O will collect this equipment at no cost to the equipment owner 
and process it accordingly. (This includes auxiliary equipment that came 
with your PSV5000 System such as Tape-Out Module, and Tray Feeder.) 
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Contact your nearest Data I/O office to receive information about 
returning WEEE labeled products with no charge. 
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Daily 

Blow off 
sockets 
 
Check input 
air pressure 

Weekly 

Run 
programmer 
Self-test, (cycle 
power) 
 
Clean surfaces 
Clean probe 
tips. 
 
Check Tray  
Feeder* 

Maintenance Sign-off Chart 
PSV5000 SN____________ 

For maintenance instructions see 

Maintenance Schedule on page 92. 

Enter name of people responsible or daily check marks: 

 

Enter initials and date: 

Name 

Sunday 

Monday Tuesday Wednesday Thursday Friday Saturday 

       

Jan. Feb. Mar. Apr. May. Jun. 

      

      

      

      

Jul. Aug. Sep. Oct. Nov. Dec. 

      

      

      

      

Jan. Feb. Mar. Apr. May. Jun. 

      

      

      

      

Jul. Aug. Sep. Oct. Nov. Dec. 

      

      

      

      

Copy this chart to 
use near your 
PSV5000 Machine 
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Enter initials and date: 

 

Enter initials and date: 

Q1 Q2 Q3 Q4 

    

    

 

 

Enter initials and date: 

Q1-Q2 Q3-Q4 

  

  

 

 

 

Enter initials and date: 

20__ 

 

 

 

Jan. Feb. Mar. Apr. May. Jun. 

      

      

      

Jul. Aug. Sep. Oct. Nov. Dec. 

      

      

      

Monthly 

Clean/inspect 
Tray Feeder* 
 
Check input air 
filter; drain 
fluid 
 
Check vacuum 
generator filters 
on head 

Quarterly 

Check vision 

Clean safety doors 

Clean the monitor 

Replace probe O-Ring 

Semi-Annually 

Check PNP head 
connections & 
fasteners 

Clean Handler PC 
filter 

Annually 

Clean and lube 
Gantry guide rails 

Perform Programmer 
Performance 
Verification test 

Check vacuum 
generator silencers 
on head 
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Index 

A 
Actuator 

speed•99 
Administrator functions•63 
Administrator Functions 

create a job•64 
security profiles•65 

Administrator Mode•68 
Air 

Connecting external air•34 
pressure•34 
turning off•38 

Air Filter 
input air regulator•107 
PNP head•108 

Algorithm Support•26 
Algorithm updates•130 
Antivirus Software•25, 38 
APS agreement•26, 130 
Automatic Tray Feeder 

connections•46 
maintenance;•148 
setup•43 
tray arrangement•47 

Automotive Performance Pak•68 
Auxiliary Tray•42 

B 
Backup system•139 
Blow-Off, adjusting•104 

C 
Calibration test, programmers•119 
CH700 

description•27 
statistics•70 
updates•130 

Cleaning•92 
Collect PS Logs•133 
Contact information•- 6 - 
Continuity retries•68 
Cover tape sensor•146 

D 
DAB 

FlashCORE•97 
LumenX•119 

Data file•64 
Device 

Jam Sensor, Tape-Out•144 
Device Jam Sensor•146 
Devices 

handling safely•14 
marking•84 
quality control•77 
transfer only•68 

Diagnostic Adapter Board 
LumenX•119 

Diagnostics Adptr Board, FC•97 
Dimensions•18 
Disabled programmers•67 
Disposal of equipment•148 
disposal requirements•- 5 - 
Dry Run•68 
Duplicating a Job•66 

E 
Electrical Input Requirements•35 
Electrical Schematics•158 
Emergency Stop buttons•12 
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Enhanced Statistics;•89 
Environmental requirements•18 
Errors teaching Package File•70 
ESD 

precautions•13 
strap•21 

External air•34 

F 
Facilities requied•18 
Fail Retries•68 
Firmware updates•130 
First Article Test•67 
FlashCORE programmers•20 
FlashPAK•66 
Fume extractor 

cleaning;•126 
maintenance•95 
replacing filter;•127 
safety•28 

G 
Gantry 

lubricating•110 
Ground connection•10, 21 

H 
Handler Computer•25 

software•25 
Home position•13 

I 
Ignore Programmers•68 
Input/Output Modules 

Automatic Tray Feeder•43 
auxiliary tray•42 
reject bin•41 
static trays•40 
tape output•47 

Install 

programmers•122 
Installation 

PSV5000•33 
room consideration•29 

IP Address•38 

J 
Job Folder 

LumenX•64 
Job statistics•71 

L 
Label Generator•90 
Language, changing•10 
Laser filter, replacing•127 
Laser marking file 

creating•84 
verifying operation•84 

Laser Marking Module 
cleaning;•124 

Laser Shuttle 
installing•81 

Laser shuttle tips 
cleaning;•125 

LCD Display 
cleaning•94 

Light Tower 
description•19 
interpretation•See Operator's Manual 

Log Files, collecting;•133 
LumenX 

Job Folder•64 
LumenX programmers•20 

M 
Machine Axes•14 
Machine Cleaning 

general•102 
Main Air Pressure•35 
Maintenance 

sign-off chart•150 
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Mark devices only•68 
Master device•80 
Monitor 

cleaning•94 
Movetimes 

teaching in the Package File•70 

N 
Network 

connections•34 
settings•36, 38 

O 
Operator 

functions listed•63 
grounding connection value•120 
mode•68 

Optimize Movetimes•70 

P 
Package File 

description•69 
movetimes•70 
reuse•69 
teaching locations•69 

Park position•13 
Password•65 
PC 

backup system•139 
drive failure•139 

Pick and Place Head•See PNP head 
Pneumatic input requirement•34 
PNP head 

descripiton•15 
moving manually•115 

PNP Probe 
re-installing•117 
replacing•114 

Pocket empty sensor•146 
Pocket Empty Sensor•144, 147 
Port Numbers•38 

Power 
applying first time•37 
connecting•35 
specifications•18 

Powering down•38 
Programmer 

air connection•123 
diagnostics•119 
ehternet connection•123 
electrical connection•123 
maintenance•93, 119 
self-calibration•93 

Programmer support•130 
Programmers 

disabling•See the Operator's Manual 
Programming Yields 

maximizing•77 
process errors•78 
socket issues•77 

Q 
Quality Control of Devices•77 

R 
Raid1 Degraded message;•139 
Reject bin•41 
Repair information•- 7 - 
Replacing 

programmers•122 
Representative search•- 7 - 
Restarting after trouble;•133 
Run one•67 
Run window•69 

S 
Safety 

doors•13 
Emergency Stop•12 
laser•27 
pinch hazard•- 4 - 
precautions•- 4 - 
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symbols•- 2 - 
ventilation•29 

Security profiles•65 
Serial Number•22 
Setup window options•64 
Shutting down•38 
Socket Actuators 

adjusting•99 
Socket Adapters 

cleaning•98 
Sockets 

cleaning•98 
yield issues•77 

Software updates•130 
Sort-on-Error-Code•71 
Specifications•18 
Static trays•40 
Statistics•70 
System Logs 

collecting•133 

T 
Tape input 

description•23 
Tape Outpu Sensors 

device jam•146 
Tape Output Sensors•147 
Tape Output Sensors;•146 
Tape Output Setup•47 
Tape-In Mount 

removing•42 
Task creation•64 
TaskLink 

creating a Package file•66 
modes•68 
session data logging•71 

Teaching the Package file•69 
Technical support•- 6 - 
Tool position•13 
Transfer devices only•68 

Tray Feeder 
maintenance•148 
setup•43 

Trays 
installing•See Operator Manaul 
reject•42 
static•40 

Troubleshooting 
air pressure problems;•138 
common errors•131 
Handler PC drive•139 
Pick & Place problems;•137 
programming errors•136 
Tray Feeder-CB problems;•139 

Troubleshooting;•131 
Turning power OFF•38 

U 
Updates 

software;•130 
User profiles•65 

V 
Vacuum generator, adjusting blow-off•104 

W 
Warranty Information•- 7 - 
WEEE Directive•148 
Winah400.ini 

updating SW;•130 
Workspace layout 

auxiliary•42 
Tray to Tray•43 

Y 
Yield, considerations•78 
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